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Chapter 1: Before you begin

Begin here to get information about Help documentation for Adobe Presenter 6. You can also find out about the tools

Adobe offers to help you get started, find system requirements for your software, and get an overview of resources

available at Adobe.com.

Resources

Help components
Help The documentation is available in Help, browser-based content you access through the Help menu of your

Adobe product.

How To topics The How To topics provide a brief overview of the most common tasks. If you need more infor-

mation, just click the links in the How To topic.

PDF version of Help To view all the Help topics in a single PDF document, open the PDF file in the Help folder where

the application is installed or on the Documentation Center at www.adobe.com/go/connect_documentation_en

Adobe Presenter resources
More information is available from the following sources:

Quick Start Adobe offers Quick Start demos for Adobe Presenter. These short demos show you visually how to do

common tasks. View the Quick Start demos at www.adobe.com/go/presenter_quickstart_en

Resource Center This site, at www.adobe.com/go/resources_connect_en, is updated regularly with tutorials, simula-

tions, best-practices information, and links to procedures.

Support Center This site, at www.adobe.com/go/support_connect_en, contains current support information,

including technical notes, helpful presentations, and support program details.

Developer Center This site, at www.adobe.com/go/devnet_connect_en, is updated regularly with tutorials and

articles about Adobe Presenter.

Documentation Center This site, at www.adobe.com/go/connect_documentation_en, for all products, answers to

frequently asked questions, articles about specialized topics, and Adobe Presenter presentations.

System requirements
The most complete listing of system requirements for Adobe Presenter can be found at

www.adobe.com/go/presenter_sysreqs_en.

Adobe.com
These resources are available on the Adobe website:

Adobe Design Center Offers articles, tips, and tutorials in various formats, including video, Adobe PDF, and HTML.

The content is authored by industry experts, designers, and Adobe publishing partners, and new content is added

monthly. You’ll also find Adobe Studio Exchange, where users download and share thousands of free actions,

plugins, and other content. Adobe Design Center is available in English, French, German, and Japanese.

http://www.adobe.com/go/connect_documentation_en
http://www.adobe.com/go/presenter_quickstart_en
http://www.adobe.com/go/resources_connect_en
http://www.adobe.com/go/support_connect_en
http://www.adobe.com/go/devnet_connect_en
http://www.adobe.com/go/connect_documentation_en
http://www.adobe.com/go/presenter_sysreqs_en
http://www.adobe.com
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Adobe Developer Center Provides information for advanced users, including software and plug-in developers.

You’ll find tutorials, SDKs, scripting guides, and sample code, in addition to forums, RSS feeds, online seminars, and

other technical resources.

Communities Features forums, blogs, and other avenues for users to share technologies, tools, and information; ask

questions; and find out how others are getting the most out of their software. User-to-user forums are available in

English, French, German, and Japanese; blogs are posted in a wide range of languages.

Using Adobe Help

Browse Help topics
1 Select a product from the Help For menu.

2 Browse to a topic:

• To browse by topic, click Contents.

• To browse alphabetically, click Index, and then click a letter.

3 Click items in the navigation pane until you reach the desired topic.

Search Help topics
1 Select a product from the Help For menu.

2 In the navigation pane on the left, click Search.

3 Type one or more words in the text box, and click Search. Topics matching the search terms appear in the

navigation pane, listed in order of relevance.

Search tips

These tips can help you improve your search results in Help:

• If you search using a phrase, such as “shape tool,” put quotation marks around the phrase. The search returns only

those topics containing all words in the phrase.

• Make sure that search terms are spelled correctly.

• If a search term doesn’t yield results, try using a synonym, such as “web” instead of “Internet.”

Navigate Help
❖ Navigate Help by doing any of the following:

• Click items in the navigation pane until you reach the desired topic. To view a topic, click its title, either in the

navigation pane or the reading pane.

• Click Back or Forward on the toolbar.

• Click Previous or Next in the reading pane.

• Click the navigation links that appear above the topic title in the reading pane.

You can also navigate Help using accessible keyboard shortcuts. For details, see “Keyboard shortcuts for navigation.”
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Get updated Help topics
If Help topics are updated or added after the product is released, the topics are posted to Adobe.com.

Adobe Help and accessibility
Adobe Help is designed so that it is accessible to people with disabilities such as mobility impairments, blindness,

and low vision. Adobe help supports standard accessibility features and alternative keyboard shortcuts for toolbar

controls and navigation.

Supported accessibility features

Adobe Help supports the following standard accessibility features:

• Standard HTML tags define content structure.

• Style sheets control formatting (no embedded fonts).

• Each frame has a title to indicate its purpose.

• Graphics without captions include alternate text.

• If link text doesn’t match the title of the destination, the title is referenced in the Title attribute of the Anchor tag.

For example, the Previous and next links include the titles of the previous and next topics.

• Content supports high-contrast mode.

• Text size can be changed with standard context menu commands or standard menu commands for Mac OS.

Keyboard shortcuts for toolbar controls

Each control in the toolbar for Adobe Help has a keyboard equivalent in Windows:

Back Alt-left arrow

Forward Alt-right arrow

Print Ctrl-p

Help For menu Alt-down arrow or Alt-up arrow to navigate choices

Keyboard shortcuts for navigation

To navigate Adobe Help, use the following keyboard combinations in Windows:

• To move between the navigation pane and the reading pane, press Control-Tab and Shift-Control-Tab.

• To move through links within a pane, press Tab or Shift-Tab.

• To activate a selected link, press Enter.

What’s new

New features in Adobe Connect Enterprise
Here are some of the new features in Connect Enterprise:

Enhanced support for integrated audio conferencing Acrobat Connect Professional now offers enhanced support

for accounts with an audio conference bridge installed, to enable synchronized telephonic audio conferences as part

of Acrobat Connect Professional meetings. For meetings with international attendees, Acrobat Connect Professional

http://www.adobe.com/go/web_help
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can now display multiple dial-in numbers, so that attendees in each country can see the dial-in number they should

use. Hosts can also block incoming attendees, and can turn on or off notifications when attendees enter or exit an

audio conference.

Improved audio conference recording You can now start and stop audio recording when you are recording a

meeting (if your Acrobat Connect Professional account has an audio conference bridge installed). This makes it

possible to test the audio recording, then restart the recording, or to record only selected segments of the audio

during a meeting.

Ability to turn Connect Event guests into users If you invite guests to your Adobe Connect Events, you now have any

easy method for turning those guests into full users. Once guests are full users they can have custom field values in

reports and they can access administration pages.

Adobe Presenter audio quality You now have the option to compress audio in presentations created with Adobe

Presenter. Compressing the audio reduces the size of audio files. To retain settings in high-quality audio, you can

choose to keep the audio uncompressed.

Custom fields in User reports In Connect Enterprise user reports, you can now include up to eight custom fields for

individual users. This feature enables you to track information about users that is important to your organization.
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Chapter 2: Adobe Presenter

Creating Presentations

About Adobe Presenter 6
Adobe Presenter 6 is a software tool for creating e-learning content and high-quality multimedia presentations

rapidly. Presenter uses Microsoft PowerPoint, a popular application that is part of the Microsoft Office suite, as a

base. Finished presentations are in Flash format (SWF file). Content created with Presenter is SCORM 1.2 and

SCORM 2004 certified and AICC compliant.

After you install Adobe Presenter, you can access the application from within Microsoft PowerPoint. You can access

all Presenter authoring functions in PowerPoint by using the Adobe Presenter menu.

Presenter complements Adobe Connect Enterprise Server 6. You can create content that includes interactive

quizzing and surveys, audio, and a customizable viewer with Presenter. Presenter sends the PPT (PowerPoint) and

PPC files, as well as presentation data, to Connect Enterprise Server.

You can add straightforward or sophisticated quizzes to presentations. Presenter supports six different types of

questions that can either be graded or used as surveys. You can use branching to guide users through different paths

in the presentation based on their answers to quizzes.

Presenter provides a simple interface for using a microphone to add audio narration to your presentation. In

addition, you can easily synchronize your PowerPoint animations with your audio narration.

The Presenter intuitive interface and its complete integration with PowerPoint eliminates the need for additional

training or Flash programming. In minutes, you can transform static PowerPoint files into dynamic web experiences

by adding audio, video, multimedia, interactive quizzes and surveys, and extensive branding. When you have created

your content, simply publish it to Connect Enterprise Server. (You can also publish to your computer to test a presen-

tation.)

After you have installed Presenter, you access the program from within PowerPoint. When you open PowerPoint, a

new menu named Adobe Presenter appears in the menu bar.

Presenter How To Topics
• “Create a Presenter presentation” on page 9

• “Record audio” on page 26

• “Add audio files to a presentation” on page 22

• “Adding quizzes and questions” on page 32

• “Add and edit attachments” on page 17

• “Create and edit themes” on page 55

• “Change slide properties” on page 12

• “Preview a presentation” on page 10

• “Publish to a Connect Enterprise server” on page 65

• “Add and edit presenters” on page 14
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Installing Adobe Presenter
After you install Adobe Presenter, you can access all of its features in PowerPoint from the newly added Adobe

Presenter menu.

Note: The latest version of the Flash Player (Flash Player 9) is installed when you install Adobe Presenter.

1 After you have downloaded the application, double-click the Presenter EXE file to install the software.

2 Follow the onscreen instructions.

A Getting Started presentation guides you through the steps required to publish your first presentation.

Upgrading to Adobe Connect Enterprise Server 6
The following information is helpful if you upgrading from a previous version of Breeze and Presenter to Adobe

Connect Enterprise Server 6 and Adobe Presenter 6.

• If you have Presenter presentations created with any version of Presenter released before Presenter 6 you may want

to update your presentations. Because of changes to the latest versions of Internet Explorer, users who view presen-

tations created with Breeze versions prior to Adobe Connect Enterprise Server 6 will need to click the content area

in the browser once before any controls are clickable. To update your presentation so users will not need to click

in the content area, open the presentation in Presenter 6 and republish the presentation. (Full information about

the EOLAS changes to Internet Explorer are available on the Microsoft website.)

• The latest version of the Flash Player (Flash Player 9) is installed when you install Presenter.

• When you install/upgrade Presenter, the old version of Presenter is uninstalled and no longer available for you to use.

Creating presentations with Presenter
Presenter lets you create sophisticated, high-impact presentations and e-learning content quickly and easily in three

steps:

1. Design your presentation.

From within PowerPoint, Presenter can help you do the following tasks:

• Use an existing PowerPoint presentation as a base for a Presenter presentation. This can save you the time and

effort of creating a new presentation.

• Perform accurate PowerPoint conversions quickly, including full support for PowerPoint animations.

• Customize the look and feel of the presentation viewer interface with company logos, colors, and presenter biogra-

phies and photos.

2. Edit your presentation.

Presenter can help you change presentations to suit your needs in the following ways:

• You can enhance PowerPoint presentations with multimedia. Add multimedia including audio (such as voice-over

narration), quizzes and surveys, or Flash files and Flash video without leaving PowerPoint.

• You can import prerecorded audio into a presentation and match the audio to PowerPoint slide animations.
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3. Publish your presentation.

You publish your presentations so that users can view them. Presenter offers the following features:

• Presenter is deeply integrated with all Connect Enterprise applications including Connect Training, Connect

Events, and Acrobat Connect Professional, as well as Adobe Captivate, Flash content, and Flash Video (FLV) files.

• You can view presentations in the interactive Presenter viewer.

• You can use Presenter content with learning management systems (LMS). Presenter creates SCORM- and

AICC-compliant content.

See also

“Add animation, image, and Flash (SWF) files” on page 19

“Create and edit themes” on page 55

“Publish to a Connect Enterprise server” on page 65

Presenter workspace
Presenter has the following two components that work together to help authors create and deliver content for users:

Presenter Enables authors to create content.

Presenter viewer Allows users to view and interact with converted Presenter presentations.

For content authors, all Presenter features are accessible from the Adobe Presenter menu in PowerPoint.

All the options for designing a presentation are in the Adobe Presenter menu in PowerPoint.

Elements of presentations
When planning, consider adding the following elements to your presentation:

Title slides Title slides are usually the first or second slide in a presentation and state the subject of the content.

Presenter information Include the name, title, photo, contact information, and a short biography of the presenter or

presenters.
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Custom logos Add a company or organization logo to brand and personalize a presentation.

Copyright information Depending on the length of the information, include copyright text on the first or last slide

in a presentation, or add a separate slide containing only copyright information.

Opening and closing slides Create a distinctive start and finish to clearly show users the beginning, middle, and end

of the presentation. You can use the same opening and closing slide across a series of presentations for a unifying

professional look.

Section divider slides Use slides that delineate sections within a presentation. This is especially useful in long

presentations.

Sounds Voice-over narration, music, or sound effects can add a new dimension to presentations.

Quizzing Let users interact with the presentation, while you track their learning progress or obtain information

(surveys).

Attachments Add existing information as supporting content for presentations. You can include documents, spread-

sheets, links to web pages, and images as attachments.

Planning a presentation
No matter what kind of presentation you want to create, it is helpful to do some planning before you start. Consider

first what you want the user to learn from your presentation. Defining this goal at the beginning lets you create a

comprehensive plan for success. After you have defined the goal of the presentation, you can use an existing Power-

Point presentation and enhance it with the most effective Presenter options.

1. Plan your presentation.

Use storyboards, scripts, or whatever organizational materials are appropriate. Consider what elements you may

want to include (see “Elements of presentations” on page 7.)

2. Start PowerPoint.

You can open an existing PowerPoint presentation or create a new presentation.

3. Include narration and other special elements.

In PowerPoint, from the Adobe Presenter menu, you can add audio narration, quizzes, presenter information, and

other options to your presentation. You can include attachments such as web pages or documents and you can

customize themes (the look and feel of the presentation viewer) for each presentation.

4. Preview your presentation.

You can view the presentation on your machine by publishing locally to test the timing and the features you have

added.

5. Publish the presentation.

You can publish the presentation to Connect Enterprise Server. You can also burn the presentation to a CD or upload

the presentation to the web using a third-party FTP software program.
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Presenter best practices
Adobe recommends these best practices for creating presentations:

• Design your online presentation based on the bandwidth capabilities of your audience. If your audience has fast,

broadband connections, you can create a graphic-intensive presentation that includes many animations. However,

if your audience has slower connection speeds, you should consider using graphic images only (no animations) or

no graphics at all, to ensure that your audience has a good viewing experience.

• Consider creating a written script before recording audio for your presentation. Speaking into a microphone can

be more difficult than giving a presentation to a live audience. To ensure a smooth delivery that covers all of your

important points, consider creating a script for the entire presentation before recording audio for it. (If you have

slide notes written in PowerPoint, you can easily import them into Presenter to use as a script or as the basis of a

script.)

• Add animations to enhance the overall presentation, if your audience has fast connections. Presenter supports

PowerPoint animations so that you can create powerful, animated, multimedia presentations. Animations add

impact to your message and improve the user’s overall viewing experience. (Animations must be set to On Click.)

• Create presentations that are a manageable size. A single PowerPoint presentation typically corresponds to a single

module or course. Usually a module contains 20-40 slides and results in a 15-45 minute sessions for users. If single

PPT files become larger than 40 slides, the time it takes Presenter to convert the presentation to Flash format can

increase by several minutes.

• Preview the presentation by publishing it locally before publishing to a Connect Enterprise Server. This lets you

view the converted presentation to be sure that it meets your requirements.

• Create slide titles to give users easy access to any slide. Check that titles appear in the PowerPoint outline for all

slides, including graphic-only slides, before publishing your presentation.

Create a Presenter presentation
Presenter presentations are always based on PowerPoint presentations. To create a new presentation, you open an

existing PowerPoint presentation (or create a new one) and then add all of the features available in Presenter. For

more information about how to add these features, see the appropriate section.

1 In PowerPoint, open a presentation (PPT) file or create a new one by selecting File menu > New.

2 From the Adobe Presenter menu, select the Presenter features you want to add to your presentation. You are not

required to make any changes before publishing, but adding Presenter features such as audio narration, SWF files,

quizzes, attachments, and a theme will enhance your presentation and give you the opportunity to experiment with

the functionality available in Presenter.

3 Preview the presentation by publishing it locally (to your computer). (For instructions on how to do this, see the

next section).

4 If necessary after previewing, return to step 2 and make any changes required.

5 When you are finished, publish the presentation to Connect Enterprise Server.

See also

“Publish to a Connect Enterprise server” on page 65



ADOBE PRESENTER 6
User Guide

10

Preview a presentation
If you want to check your work, you can preview presentations at any time by publishing to your local computer. This

is a fast way to see how the presentation will look to users.

When you preview a presentation, it appears in your default web browser. All of the functionality in the presentation,

such as audio and quizzes, works exactly the way it will in the Presenter viewer. The presentation appears with all of

the theme settings and colors you have chosen.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Publish.

3 Select My Computer on the left side.

4 (Optional) Select Zip files to add all presentation files to a zip file. This is useful if you need to give or send the

files to someone else to preview.

5 (Optional) Select Generate Autorun For CD if you are going to distribute the presentation on a CD-ROM after

previewing. (If you select this option, you can burn the presentation on a CD-ROM and when it is opened, the

presentation automatically begins playing.)

6 Click Publish.

When you publish, a new folder with the same name as the presentation is created and placed in your My

Documents\My Adobe Presentations folder. The new folder contains all of the presentation files, copies of attach-

ments, and any audio, video, and image files that are part of the presentation.

7 When the conversion is finished, click View Output. (If you selected the Select Zip files option, you will not see

the View Output option. To view the presentation, go to the location where you saved the zip file, unzip the file, and

double-click the index.htm file.) The presentation appears in your default web browser.

Published presentation with sidebar shown
A. Slide preview B. Viewer sidebar C. Panes D. Toolbar E. Show/Hide sidebar

A

D E

B

C
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Published presentation with sidebar hidden

Editing Presenter Presentations

Change the presentation title
You can change the presentation title at any time. The title appears in the Presenter viewer.

The presentation title appears at the top of the browser window and in the Viewer sidebar.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Select the Settings tab.

4 In the Title text box, enter a new name for the presentation and click OK.

Add a presentation summary
A presentation summary is usually a short description of the presentation contents. This optional presentation

summary is a useful organizational tool for authors. The summary appears only in the settings; it does not appear in

the published presentation and is not visible to users.

Note: The presentation summary does appear in Connect Enterprise Server after a presentation is published to the

server. Summaries can be edited through Connect Enterprise Manager. Presentation authors can search summaries and

see the summary when viewing content information.

1 In PowerPoint, open a presentation (PPT file).



ADOBE PRESENTER 6
User Guide

12

2 From the Adobe Presenter menu, select Presentation Settings.

3 Select the Settings tab.

4 In the Summary text box, enter a description of the presentation contents and click OK.

Change slide properties
You can easily view and change the properties of any slide in a presentation at any time. Slide properties include the

title, navigation name, navigation options, and presenter name. The slide properties dialog box also enables you to

make changes to a group of slides quickly and easily. For example, suppose you have assigned a presenter to all the

slides, but another presenter is providing audio narration for a few of them. To assign the new presenter to those few

slides, you can use slide properties.

Note:You can select multiple slides and easily update their Presenter and Advance By User settings. Simply select a slide,

hold down Shift or Control, and select additional slides. (You can’t change the Navigation name, Go To Slide, or Video

properties of more than one slide at a time.)

Using slide properties, you can change options for individual slides or a group of slides.
A. Select one slide or multiple slides in the list. B. Click to edit the selected slides

See also

“Preview a presentation” on page 10

View slide properties for all slides

You can view a short description of all slides in a presentation in one central location. For example, you can see which

presenters are associated with each slide, whether navigation names have been assigned, and whether the user must

advance any slides.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Slide Properties.

The Slide Properties dialog box appears.

3 Use the scroll bar on the right side to view all of the slides in the presentation.

A

B
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Set a navigation name

You can set a navigation name for a slide that is different from the slide title. A clear and descriptive navigation name

can help users navigate through the published presentation. The navigation name appears in the sidebar (Outline

and Thumb panes) in the published presentation.

A navigation name can be useful if your slide titles are long or if you want to display a more descriptive name than

the slide title in the final presentation for users. For example, the first slide in the presentation may have the title

“Introduction,” but you can assign a navigation name such as “About Product X.”

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Slide Properties.

3 Select a slide and click Edit or double-click a slide.

4 In the Navigation Name text box, enter the text you want to use.

5 Click OK twice.

Slide titles (left) changed to navigation names (right)

Set Go To Slide options

Presentations usually progress linearly through the slides, but you can change the order by using the Go To Slide

option. This option lets you skip slides in the presentation without having to remove them.

The Go To Slide option can be useful if you are creating a presentation for several audiences. For example, you can

create one benefits presentation for both full-time and part-time employees. Part-time employees can skip slides

pertaining only to full-time employees. The Go To Slide option works the same whether the presentation is used

within Acrobat Connect Professional or viewed locally in a web browser.

Note: If you are going to use a presentation as a Connect Training course, it is better to not use the Go To Slide option.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Slide Properties.

3 Select a slide as the starting point and click Edit or double-click a slide.

4 In the Go To Slide pop-up menu, select the slide to which you want the presentation to jump.

5 Click OK twice to close all dialog boxes.

Add speaker video

You can include video files in a presentation, which appear in the viewer sidebar. This can be especially useful if you

have a video of a speaker, sometimes called a “talking head” video. Presenter supports the Flash (SWF) and Flash

Video (FLV) file formats. Video added to a presentation appears in the location used for presenter photographs.
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Note: Video is added to each slide individually. If you use one “talking head” video file for multiple slides, split the video

into separate files.

Video files appear in the viewer in the same location as the presenter photograph.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Slide Properties.

3 Select a slide and click Edit or double-click a slide.

4 Next to the Video text box, click Browse.

5 Navigate to a SWF or FLV file, select the file, and click Open.

6 Click OK twice to close all dialog boxes.

7 To test the file, preview the presentation. (For more information, see “Preview a presentation” on page 10).

Set slide advance behavior

By default, slides in a presentation advance automatically. You can, however, set individual slides to advance only

when users click the Next button. This is useful, for example, for a slide containing an interactive Adobe Captivate

simulation that has no set play duration.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Slide Properties.

3 Select a slide and click Edit or double-click a slide.

4 Select Advance By User.

5 Click OK twice.

Add and edit presenters
A presenter is a person who provides information during a presentation. For example, if the subject is software

training, the presenter may be an instructor, trainer, or product manager. A single presenter can be assigned to all

slides in a presentation, or different presenters can be assigned to individual slides.

You can display information about the presenter: name, job title, short biographical notes, a company logo, and

contact information. This information can make a presentation more credible, personal, and interesting.
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See also

“Preview a presentation” on page 10

Add a new presenter profile

In Presenter, you store presenter profiles in one central location. You can then use them in any presentations you

create.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Select the Presenters tab.

4 Click Add.

5 Enter the name of the new presenter.

Note: The Name text box is the only text box that you must fill in to create a new presenter.

6 (Optional) Enter a job title, such as Vice President.

7 (Optional) Next to the Photo text box, click Browse and navigate to an image file in JPEG or PNG format. The

recommended size for a presenter photo is 88 x 118 pixels. After you select an image file, the image appears in the

Presenter Photo area on the right. During the presentation, the image is displayed at this exact size in the Presenter

viewer.

8 (Optional) Next to the Logo text box, click Browse and navigate to a logo file in JPEG or PNG format. The recom-

mended size for a logo is 148 x 52 pixels. After you select an image file, the image appears in the Logo preview on the

right. During the presentation, the logo is displayed at this exact size in the Presenter viewer.

Note: If you added a video file, such as a “talking head” video file of a person speaking, that video is displayed in the logo

area. If you add a logo file, the video file takes precedence and the logo will not be displayed.

9 (Optional) Enter an e-mail address.

10 (Optional) In the Biography text box, enter information about the presenter, such as professional and educa-

tional credentials, employment history, phone number, or job description.

11 If you want to make this person the default presenter for all presentations, select the Default option.

12 Click OK.

13 Click Close.

Set the presenter for an entire presentation

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Slide Properties.

3 Press CTRL-A to select all of the slides.

4 Click Edit.

5 In the Presenter pop-up menu, select a name from the list.

6 Click OK. The presenter is now associated with all slides in the presentation.

7 Click OK to apply your changes and close the Slide Properties dialog box.

Set the presenter for an individual slide

1 In PowerPoint, open a presentation (PPT file).
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2 From the Adobe Presenter menu, select Slide Properties.

3 Select a slide and click Edit or double-click a slide.

4 In the Presenter pop-up menu, select a name from the list.

5 Click OK. The presenter is now associated with the slide.

6 Click OK to apply your changes and close the Slide Properties dialog box.

Edit an existing presenter

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Select the Presenters tab.

4 Select a presenter from the list and click Edit or double-click a presenter.

5 Change properties such as the job title, e-mail address, or biography.

6 Click OK to close the Presenter dialog box.

7 Click Close to close the Presenter Preferences dialog box.

Delete a presenter

You can delete a presenter and all corresponding information, such as the biography and e-mail address, at any time.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Select the Presenters tab.

4 Select a presenter from the list and click Delete. (If the presenter you delete is associated with any slides in the

presentation, the presenter for that slide becomes “None.”)

5 Click Close to close the Presenter Preferences dialog box.

About attachments
Attachments are files or links that give viewers of the presentation supplemental information. Use attachments to

incorporate existing content, such as web pages, documents, PDF files, FlashPaper documents, Flash (SWF) files, or

spreadsheets, into your presentation. You can also add links to websites or documents hosted by Connect Enterprise

Server or a third-party system.

If a presentation contains attachments, an Attachments button appears at the bottom of the Presenter viewer. The

user can click this button to see a list of attachments associated with the presentation and then click any listed

attachment to open it.

Note:Depending on the user’s web browser, they may have to save an attachment to their local machine in order to open

and view the attachment.
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The Attachments window with several different types of attachments listed.

Attachments open either in an application or in the default browser, according to their type:

Add and edit attachments
You can attach web pages, documents, PDF files, FlashPaper documents, Flash (SWF) files, or spreadsheets to your

presentation. You can also add links to websites or documents hosted by Connect Enterprise Server or a third-party

system.

Important: Due to security features added by Microsoft, attachments to presentations that are published locally instead

of to Connect Enterprise Server may not be displayed properly in Internet Explorer. This happens because Internet

Explorer does not allow an Internet page to access or run any file on a local system. In Adobe Presenter, a presentation

that has been published locally runs in the Flash player, and Internet Explorer considers it unsafe to download a file from

the Flash Player. You can work around this issue two ways: use Connect Enterprise Server (or another Learning

Management System) to publish the presentation, or make the attached file available for download through a web

browser or network drive accessible by users and use the hyperlink feature of PowerPoint to allow users to view the

attachments.

Add an attachment to a presentation

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Select the Attachments tab.

4 Click Add.

Attachment type Opens in

FlashPaper Default web browser

Microsoft Word document Microsoft Word, if installed

Microsoft Excel spreadsheet Microsoft Excel, if installed

Microsoft PowerPoint presentation Microsoft PowerPoint

Text (TXT) file Default text editor, such as Notepad or Wordpad

PDF file Adobe Acrobat Reader, if installed

Flash (SWF) file Default web browser, such as Internet Explorer or Mozilla Firefox

Image or graphic file Default web browser, such as Internet Explorer or Mozilla Firefox

URL Default web browser, such as Internet Explorer or Mozilla Firefox
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5 Enter a unique name for the attachment.

6 In the Type pop-up menu, select File or Link.

• To attach a file, click Browse and navigate to the file.

• To attach a link, enter the full path in the URL text box.

7 Click OK.

8 Continue adding attachments as needed and click OK when you finish.

Add and test links to documents

Links to documents on Connect Enterprise Server or a third-party system are a type of attachment. For example, you

could create a link from a text on a PowerPoint slide to a SWF file.

When linking to a document, it may be necessary to copy the document to the resource folder for the document to

appear properly in the presentation.

1 In PowerPoint, open a presentation (PPT file).

2 Navigate to the slide to which you want to add the link.

3 Select the text you want to use as the link.

4 From the Insert menu, select Hyperlink.

5 Navigate to the file to which you want to link and click OK.

6 To test the link, preview the presentation. From the Adobe Presenter menu, select Publish.

7 Select My Computer and click Publish. (If a message appears stating that all files will be deleted, click Yes. Each

time you generate your presentation, the files in your current output folder are deleted and replaced by the newly

generated files.)

8 When the conversion is complete, click View Output. The presentation appears in your default web browser.

9 Navigate to the slide containing the link and click the link.

10 If a message appears stating something similar to “Cannot find ‘file://c:\Documents and Settings\ssmith\My

Documents\My Adobe Presentations\PresentationName\data\resources\sample.swf,” you need to copy the file to

the resources folder. Note the path specified in the message and close the presentation in your web browser.

11 Open Windows Explorer. Navigate to the current location of the file.

12 Right-click the file and select Copy.

13 Navigate to the location specified in the error message, For example, an address similar to the example in step 10.

14 Right-click the resources folder and select Paste.

15 Follow steps 6-8 to preview the presentation and test the link again.

Creating links to files

If you are creating links from a presentation to a file and the link path is relative to the location of the presentation,

you may need to take a few steps to ensure that the links work properly. This issue occurs because of the method

PowerPoint uses to manage relative links. (PowerPoint does, however, resolve all links to files in the same drive as

the PPT file.)

1 In Windows Explorer, locate the folder containing the presentation PPT file. For example, C:\Folder A\test.ppt.

2 Create a subfolder under the folder containing the presentation PPT file. For example, C:\Folder A\Links.
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3 Copy all files that will be linked to from within the presentation to the new subfolder.

4 Create the links in the presentation to the files.

5 Publish the presentation. Note the location of the published content folder.

6 Copy the subfolder created in step 2 containing the links to the Date\Resources subfolder of the published content

folder from step 5. For example, copy the links folder from C:\Folder A\Links to C:\Preso\Data\Resources\Links.

Note: You can use attachments instead of links. By using attachments, the files are automatically included with the

published content.

Change the name, type, or location of a presentation attachment

After adding an attachment to a presentation, you can edit information about the attachment.

Note: If you need to edit the attachment contents, open the file in the application in which it was created. After editing,

add the attachment again in Presenter.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Select the Attachments tab.

4 Select an attachment and click Edit or double-click an attachment.

5 Make changes to the name, type (file or link), or location and click OK.

6 Click Close.

Delete a presentation attachment

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Select the Attachments tab.

4 Select an attachment and click Delete.

5 Click OK.

If a folder containing attachments is inadvertently deleted, the next time the presentation (PPT) file is opened and

saved, a dialog box appears for each deleted attachment stating that the attachment is missing. The dialog box

contains three options: browse to the attachment using Windows Explorer, delete the attachment from the presen-

tation, and ignore. If ignore is selected, the dialog box will not appear again unless the presentation is closed,

reopened, and then Save is selected.

Add animation, image, and Flash (SWF) files
You can incorporate animations and Flash (SWF) files into your Presenter presentations.

If you already have PowerPoint animations, such as flying or dissolving text, Presenter converts them seamlessly and

displays them in the final presentation exactly as they appear in PowerPoint. (For the most current list of supported

PowerPoint animations, see the Adobe Knowledgebase.)

Note: In order for Presenter to gain control of animations, they must be set to OnClick. Animations located on the Slide

Master cannot be controlled; remove the animations from the Slide Master and place them on individual slides

You can also incorporate SWF files into your presentation, including SWF files containing animation and SWF files

containing simulations and demonstrations created with Adobe Captivate.

http://www.adobe.com/go/tn_18774
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See also

“Change slide properties” on page 12

“Preview a presentation” on page 10

Synchronize audio and animation timings

After previewing your presentation, you might want to edit the timing of PowerPoint animations to better

synchronize with added audio files. For example, if you have a slide with bulleted text items that appear one by one,

you can adjust the timing so that the audio track matches the action of the text.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Synchronize Audio.

3 In the Synchronize Audio dialog box, click Previous or Next, if necessary, to navigate to the slide containing the

timing that you want to adjust.

4 Select Change Timings  to play the audio.

5 As the audio plays, click Next Animation to synchronize the timing of the first animation with the audio. Select

Next Animation again to synchronize the timing of the next animation. Repeat this step for all animations on the

slide.

6 When you finish, click Stop Editing.

7 Click OK.

Note:The Synchronize Audio dialog box synchronizes PowerPoint “On mouse click” animations only. In contrast, timed

animations use the timing set in the Custom Animation dialog box in PowerPoint.

Pause the presentation after an animation plays

If your presentation includes PowerPoint animations, you can pause the presentation automatically after the anima-

tions play. This is useful if you want to clearly define where the animation ends and the presentation begins again.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Click the Settings tab.

4 Select Pause After Each Animation.

5 Click OK.

When this option is selected, users must click the Play button in the toolbar to start the presentation again after

a pause.

Insert a SWF file into a presentation

A Flash (SWF) file is a compiled, view-only Flash file that delivers graphics and animation over the Internet. You can

use a SWF file to add content or visual interest (for instance, an animated pointer) to a presentation.

Note: If you have created animated simulations and demonstrations in Adobe Captivate, you can easily add them to

your presentations. Certain Adobe Captivate projects, such as training demonstrations or software simulations, can be

particularly useful in presentations.

1 Make sure that the file you want to insert meets these specifications:

• The Flash SWF file has been authored at 30 frames per second. Presenter presentations are created at 30 frames

per second, so Flash files with the same setting can be integrated into the presentation smoothly.
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• The maximum canvas size is set to 720 x 540 pixels.

• The file uses relative paths to movie clip references, not _root.

• The embedded SWF file does not attempt to make any changes outside its own file; that is, that the code does refer

to the following variables: _level#, _global, or stage.

2 In PowerPoint, open a presentation (PPT file).

3 Navigate to the slide to which you want to add the SWF file.

4 From the Adobe Presenter menu, select Insert Flash.

5 Navigate to the location of your SWF file. Select the SWF file and click Open. Presenter adds the SWF file to the

slide.

6 (Optional) If necessary, select the file and drag it to a new location on the slide.

Note: You can use PowerPoint to preview how the SWF content will appear in your presentation. In PowerPoint, from

the View menu, select Slide Show.

Control an inserted SWF through the Presenter playbar

When you add a SWF file to a presentation, you can choose whether to control the SWF file through the Presenter

playbar or the playbar in the original SWF file. For example, if you add a Adobe Captivate demonstration SWF file

to the presentation, you can control the demonstration through the Presenter playbar in the viewer or the playbar in

the Adobe Captivate demonstration.

Ordinarily, you want to control the SWF file through the Presenter playbar, because Presenter buffers the two slides

that will be presented next. If you don’t control the file through the Presenter playbar, the SWF file could begin

playing too early.

1 In PowerPoint, open a presentation (PPT file) containing an added SWF file.

2 From the Adobe Presenter menu, select Presentation Settings.

3 Click the Flash Files tab.

4 Select one of the Flash files in the list.

5 Select the Controlled By Presentation Playbar option to control the SWF file through the Presenter playbar.

6 Click OK.

Set image quality for a presentation

The higher the image quality, the greater the file size. Test different settings to find the best compromise between the

two. High quality is best for users with no bandwidth limitations; for users with limited bandwidth, regular or low

quality may be better.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Select the Quality tab.

4 Select an image-quality option:

High The largest file size and highest quality image.

Medium The best balance between file size and image quality.

Low The smallest file size and lowest quality image.



ADOBE PRESENTER 6
User Guide

22

5 (Optional) If you think users might view your presentation on computers with slow connections speeds, select

Require Slides To Download Completely Before Playback. If this option is enabled, it will take longer for the presen-

tation to start, but the slides will play smoothly after the presentation begins.

6 (Optional) If your presentation contains Flash movies (for example, Adobe Captivate content), select Disable

preloading of embedded Flash movies. This option enables single and multiple SWF files to play properly in the

presentation. For example, the option prevents a second SWF file from beginning to play before a first SWF file is

finished.

7 Click Close.

Audio in Presentations

Using audio in presentations
Adobe Presenter lets you add narration, music, step-by-step instructions, or almost any sound to your projects. You

can use audio to provide instructions or to emphasize key points in the presentation. In general, sound can be as

individual and flexible as any other presentation component.

You can use audio in Presenter presentations in a variety of ways. For example, Presenter can help you with the

following tasks:

• Adding sound to an individual slide

• Adding special sounds to quizzes for correct and incorrect answers

Presenter lets you record your own audio files (using some simple equipment) or import existing files. Imported files

can be in WAV or MP3 format. (If you add a WAV file to a presentation, Presenter automatically converts the WAV

file to MP3 format in the generated presentation.)

After you add audio to a presentation, you can synchronize the timing with other content, such as animations. For

example, if your presentation contains PowerPoint animations such as text that “flies in,” you can synchronize the

animations with the audio. (For more information, see “Add animation, image, and Flash (SWF) files” on page 19.)

Presenter also contains features that enable you to add silent periods to audio files and to normalize audio for all

slides so that the sound level is consistent.

Add audio files to a presentation
You can quickly add existing WAV or MP3 format audio files to a presentation. Simply import the files and use them

as opening music, narration, instructions, or for any other purposes.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Import Audio.

3 Select the slide to which you want to add the audio file.

4 Click Browse and navigate to the audio file (WAV or MP3) you want to add to the slide.

5 Select the audio file and click Open. (You can add multiple files. If you select more than one, the first audio file is

added to the slide you selected in step 3, the next file to the slide immediately following, and so on.)

Presenter adds the audio file to the selected slide. The name of the audio file appears in the File column, and the

length of the audio file appears in the Time column.
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Note: You can add as many audio files as you want, but they cannot exceed more than 90 minutes of audio per slide in

a presentation.

6 (Optional) Select the Ignore Markers option to ignore any sound markers placed in the audio file.

7 (Optional) Select the Compress option to reduce the size of the imported audio file. We recommend compressing

audio files when possible. Audio files that are not compressed require significantly more storage space than

compressed audio. However, if you have an audio file created with high-quality settings and you want to retain the

quality level, consider leaving this option unselected. (Please note that selecting the Compress option will compress

all audio in the presentation, not just imported audio. For example, if you use the record audio feature to record some

voiceover narration for a slide, that audio file will also be compressed.)

Recording audio
In addition to adding existing audio files, you can also record your own audio files to use in Presenter presentations.

Follow these tips to ensure that you are recording the highest quality audio possible.

Setting up audio equipment

When you have acquired the necessary audio recording equipment, you must set it up properly. First, plug the micro-

phone into the mixer or stand-alone preamplifier, and then plug the output of that device into your computer sound

card’s “line in.” Plug the headphones into your computer. Then, set the volume on the mixer or preamplifier. Begin

speaking to test the volume levels, and carefully raise the volume until it shows just under zero.

Setting sound card options

You can open the software application that controls the sound card. (In most Windows operating systems, you can

find sound settings by clicking Start in the lower-left corner and selecting Settings > Control Panel > Sounds.) When

you select the recording source (line in), you can adjust the volume to 100%. If you are using a mixer or stand-alone

preamplifier, the actual recording level can be controlled from there.

Note: Realtek codecs are not compatible with Presenter.

Changing audio recording settings

After starting your audio recording software, you can change the settings as necessary. Mixers and preamplifiers

don’t have sound-level controls, so you rely on the meters when recording. While recording, you should ensure that

you don’t exceed zero on the meters, or the sound will be distorted.

Placing the microphone

Positioning your microphone correctly can make a big difference in the finished audio file. First, get as close as

possible to the microphone (within 4 to 6 inches) so that you avoid recording any other nearby sounds. Don’t speak

down to the microphone; instead, position it above your nose and pointed down at your mouth. Finally, position the

microphone slightly to the side of your mouth, because this can help soften the sound of the letters s and p.

Improving microphone techniques

Have a glass of water nearby so you can avoid “dry mouth.” Before recording, turn away from the microphone, take

a deep breath, exhale, take another deep breath, open your mouth, turn back toward the microphone, and start

speaking. This can eliminate breathing and lip-smacking sounds frequently recorded at the beginning of audio

tracks. Speak slowly and carefully. You may feel that you are speaking artificially slowly, but you can adjust the speed

later by using your audio recording software. Finally, keep in mind that you don’t have to get everything right the

first time. You can listen and evaluate each recording and re-record if necessary.



ADOBE PRESENTER 6
User Guide

24

Editing sound

Editing sound is similar to editing text. You should listen carefully to your recording, delete any extraneous sounds,

and then use the options available in your software to polish the sound. You can add any music or sound effects you

require, but make sure to save your audio track in the correct format (MP3 or WAV files).

Reviewing the presentation

After you have added the audio to the presentation, listen to it again. You should view the presentation as users

normally would. Finally, it helps to ask others to preview the presentation file. If necessary, you can edit the audio

again, on a per-slide basis.

About audio recording equipment
Having the right audio equipment makes a big difference in the quality of recorded audio. Surprisingly, basic audio

equipment can be relatively inexpensive; your equipment should include some if not all of the following:

Computer with a sound card The sound card installed in your computer acts as a digital recorder for audio.

Microphone If possible, avoid using the USB microphone packaged with your computer. Use a professional-quality

microphone cable and a stand to hold the microphone while you are recording.

Microphone preamplifier A preamplifier boosts the signal of the microphone. The microphone input of your

computer’s sound card probably includes a preamplifier, but it’s most likely a poor quality one. When purchasing a

preamplifier, you can choose a small mixer or a stand-alone version. Mixers let you connect several microphones and

devices to one location, and you can adjust their volumes independently. Stand-alone preamplifiers can be better

than mixers at filtering out unwanted noises.

Speakers The speakers that came with your computer are probably good enough for listening to any audio you

record. For best results, check the specifications of your speakers and use the highest quality speakers possible.

In Microsoft Windows operating systems, you can usually find speaker (sound) settings by clicking Start in the

lower-left corner and selecting Settings > Control Panel > Sounds.

Recording software A wide range of recording software is available. Important software features include editing

capabilities (to fix mistakes), music and sound-effect options, and the capability to create the file format you require

(such as MP3 or WAV).

Recording area You need a quiet place to record. Try closing doors, turning off any unnecessary computer

equipment, turning off or lowering lights that might be making noise, turning off phone ringers, beepers, and pagers.

Also, tell coworkers that recording is in progress.

Set audio recording quality
Audio files present the common challenge of balancing quality against size. The higher the sound quality, the larger

the file size. The more you compress a sound and the lower the sampling rate, the smaller the file size and the lower

the quality. Presenter lets you control the way sound is recorded and compressed based upon your input and output

requirements.

Creating audio in Presenter is essentially a two-part process: you record audio in WAV format and then Presenter

converts the WAV file into an MP3 file.
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Of course, when working with audio, you must keep your users’ connection speed in mind. If a user is likely to access

the Presenter presentation by using a dial-up modem, use a higher compression and lower sampling rate, such as 56

Kbps. However, if you are distributing the presentation on a CD-ROM, you can use a lower compression and higher

sampling rate, such as 144 Kbps. In the best development case, you should experiment to find the optimal balance

between sound quality and file size for your users.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Select the Quality tab.

4 Select an audio quality level. Remember that a higher quality level results in a larger audio file size. (To publish

the presentation without including any audio files, select Publish without audio.)

5 (Optional) If you think users might view your presentation on computers with slow connections speeds, select

Require Slides To Download Completely Before Playback. If this option is enabled, it will take longer for the presen-

tation to start, but the slides will play smoothly after the presentation begins.

6 (Optional) If your presentation contains Flash movies (for example, Adobe Captivate content) on consecutive

slides, select Disable preloading of embedded Flash movies. This option prevents a second SWF file from beginning

to play before a first SWF file is finished.

7 Click OK.

Change the audio input source
If you are recording audio for a presentation, you can either use a microphone or the line-in option that is usually

included with an external audio device such as a tape deck or stereo amplifier.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Select the Audio Source tab.

4 In the Audio Input Source area, select either Microphone or Line in.

5 (Optional) Select the Always Prompt to Set Microphone Level Before Recording option if you want to calibrate

the microphone before each recording session. This is useful if you use different microphones or if you record in

different environments (for instance, a quiet room versus an area with background noise).

6 Click Close.

Calibrate microphones for recording
If you are recording audio for a presentation, you must set the microphone or recording device to the correct

recording level. This process is called calibrating the recording device. Presenter can detect optimal microphone and

recording sensitivity levels automatically.

Presenter must detect your recording device before calibrating it. Before you calibrate, check that your recording

device is connected to your computer properly and is turned on.

Note: Realtek codecs are not compatible with Presenter.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Record Audio.

The Set Microphone Recording Level dialog box appears.
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3 To set the correct recording device level, speak the following sentence into the microphone until the red recording

window becomes green: “I am setting my microphone recording level for use with Presenter.”

4 When you finish, click OK.

Record audio
If you have a microphone connected to your computer, you can record audio for inclusion in a slide. You can use

audio for many types of narration or instruction.

Record audio buttons
A. Record B. Play C. Pause D. Stop

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Record Audio.

3 Calibrate your microphone by following the instructions in the Set Microphone Recording Level dialog box.

4 Click OK.

5 Click Record Audio to begin recording.

6 Speak into the microphone or recording device.

7 When you finish, click Stop.

Presenter converts the audio to MP3 format.

8 Click Play to listen to the recording.

9 (Optional) Click Previous or Next to record audio for another slide.

10 When you finish, click OK.

Record audio for a specific location in a presentation
At times, you may need to record and add some audio to a specific location within a presentation. (To record audio,

you must have a microphone or recording device plugged into your computer.)

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Audio Editor.

3 Click the location within the waveform to which you want to add new, recorded audio. For example, if you have

an audio file playing on slide 1 and you need to add audio at the start, click the beginning of the audio file on slide 1.

You can add audio to any location on the waveform, even a location that does not currently have audio.

4 From the Insert menu, select Recording.

5 Set the type of recording device you are using by clicking the drop-down menu under Input Source and selecting

either microphone or line in.

A B C D
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6 Set the Volume level at which the recording should be made. The default setting is 100%. To change the setting,

slide the volume slider bar to the left or right.

7 To set the optimal recording level and sensitivity for your input source (microphone or line in), click Calibrate.

8 To begin recording, click the Start Recording button  and begin talking.

Length The length of the recording as you record.

Stop Click this Stop button  to end recording.

9 To listen to the recording, click the Play button .

10 Click OK. The audio you just recorded is added to the location you specified on the waveform.

Waveform before (top) and after adding a new recording (bottom)

Import slide notes
If you have created slide notes in PowerPoint, you can import the notes into the script window in the Record Audio

dialog box or the Synchronize Audio dialog box. This is useful if you want to use the slide notes as a script when

recording an audio file as voice-over narration.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Record Audio or Synchronize Audio.

3 If necessary, select the View script option.

4 Click Import Notes.

5 Select the slide notes to import:

Current Slide Imports notes from the slide that is currently displayed.

All Slides Imports notes from all slides in the presentation.

Slides Lets you select slides in the presentation. To select multiple slides, hold down Shift or Control and select the

slide numbers in the list.

6 Select the import options:

Append Imported Notes To Current Scripts Adds imported notes to the end of existing scripts.

Replace Current Scripts With Imported Notes Removes existing scripts before importing the notes selected on this

dialog box.

7 Click OK.
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Export scripts into PowerPoint
You may have used the Record Audio dialog box or Synchronize Audio dialog box to create or modify a script in

Presenter. If so, you can export the script to PowerPoint as slide notes.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Record Audio or Synchronize Audio.

3 If necessary, select the View script option.

4 Click Export Script.

5 Select the scripts to export. You can choose the current script, all scripts, or scripts on specific slides.

6 Select an export option. You can append scripts to existing PowerPoint notes (adding script text to the end of any

existing PowerPoint slide notes text) or replace existing PowerPoint notes with scripts.

7 Click OK.

Add silence to an audio file
You can add a period of silence to any audio file that is part of a Presenter presentation. This feature is particularly

useful in the following situations:

• If you import an audio file and need to synchronize the audio with slides

• If you need to make an existing audio file work in a presentation without having to edit the audio extensively

• If you have inserted a Flash file with audio, such as a “talking head” video of a speaker, into a presentation and

want to synchronize the Flash file audio with slides

1 In PowerPoint, open a presentation (PPT file) containing audio files.

2 From the Adobe Presenter menu, select Audio Editor.

3 Use the Audio Editor to add silence anywhere in a presentation, including a specific location within an audio file.

Click the location in the presentation, or the exact location within an audio file, on the waveform to which you want

to add the silent period.

4 From the Insert menu, select Silence.

5 In the Insert text box, enter a number specifying the duration of silence (in seconds).

6 In the Seconds at text box, specify where to add silence:

Cursor Position (default) This option adds silence at the point in the waveform you selected in step 3.

Start of Slide This option adds the silent period to the beginning of the slide containing the location selected in

step 3.

End of Slide This option adds the silent period to the end of the slide containing the location selected in step 3.

7 Click OK.

Presenter adds the silent period to the audio file and displays it as a waveform.

8 To test the audio file with the silence added, click Play in the lower-left corner of the Audio Editor dialog box.
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Adjust audio volume
You can adjust the volume of audio files included in your presentations. After adjusting the volume, preview the

presentation to see if the sound level is acceptable.

1 In PowerPoint, open a presentation (PPT file) containing audio files.

2 From the Adobe Presenter menu, select Audio Editor.

3 From the Tools menu, select Volume.

The Adjust Volume dialog box appears.

4 Click the volume slider on the left, and drag it up to increase volume, or down to decrease volume.

5 You can change the audio processing options, as follows:

Normalize Adjusts the sound volume automatically. Normalizing audio helps keep the sound level consistent

between slides.

Dynamics Amplifies quiet sections of the audio to help compensate for variations in audio volume.

6 (Optional) Click Advanced Controls.

Ratio Specifies the maximum amplification that Presenter will use. The default setting of 2.0 sets the quietest

sections of the audio to be amplified by a factor of 2. A higher setting can improve a project that has large disparities

between quiet and loud sections, but can also amplify background noise.

Noise Threshold Controls the amplification of background noise. Presenter doesn’t amplify any sound below the

threshold. If background noise is amplified too much, try a higher noise threshold. (Note that the Dynamics option

does not work well with high noise levels.)

7 When you finish, click OK twice to close all the dialog boxes.

Edit audio files
You can edit the audio in your presentation at any time. Using Audio Editor, you can listen to an audio file, insert

silence, adjust volume, and change a number of other options.

Use the Audio Editor to edit audio files you record for a presentation or import into a presentation.
A. Select a slide from the pop-up menu B. Slide divider and Red marker line C. Time D. Waveform E. Audio files F. Place cursor or drag to
select for editing G. Playhead H. Total or selected playing time I. Scale

1 In PowerPoint, open a presentation (PPT file) containing audio files.

2 From the Adobe Presenter menu, select Audio Editor.

A

E F

B C

D

G H I



ADOBE PRESENTER 6
User Guide

30

3 Use the buttons and menu options to make any necessary edits. You can cut and paste sections of the audio file,

insert periods of silence to lengthen the audio file, adjust volume, import a different audio file, and more.

Cut Cuts the selected portion of the audio file.

Copy Copies the selected portion of the audio file.

Paste Pastes information from the Clipboard. (For example, if you select a section of the audio file, and then click

Cut or Copy, Presenter places the selected audio on the Clipboard. You can then click Paste to place the audio back

into any location within the audio file.)

Delete Removes the selected portion of the audio file.

Undo Undoes the previous action.

Redo Redoes the previous action.

Zoom In Enlarges the waveform.

Zoom Out Shrinks the waveform.

Record/Insert New Audio Begins recording audio. (You will need a microphone.)

Play Starts the audio file.

Pause Temporarily stops the slide from playing. (Click Play to resume playing the audio file.)

Stop Ends playback of the audio file.

Slide Number Specifies the slide selected in the waveform. For example, slide 4 or 12.

Playhead Specifies the selected location, in seconds, within an individual slide on the waveform. For example, if you

are working with a slide that is 5 seconds long and you click in the middle of the slide on the waveform, this playhead

area displays approximately 00:00:02.500.

Selected Specifies the total playing time of the presentation, if no span of time is selected on the waveform. If you

have selected a span of time on the waveform, this area displays the amount of time selected.

Scale Specifies the scale at which the waveform is displayed. (To change the scale, click Zoom In or Zoom Out.)

4 When you finish editing the audio file, click OK.

Manage audio files with the Audio Editor
Presenter lets you edit the timing of audio files after you record or import them. Having control over the timing of

audio files gives you the ability to use audio files of different lengths and incorporate them smoothly into presenta-

tions.

After you record or import an audio file, the file appears as a waveform in the Audio Editor dialog box. If your

presentation contains multiple audio files, you can see which audio files are assigned to specific slides.

Edit audio timing

1 In PowerPoint, open a presentation (PPT file) containing audio files.

2 From the Adobe Presenter menu, select Audio Editor.

In the Audio Editor dialog box, Presenter displays any audio files incorporated into the presentation as waveforms.

Slide numbers along the top of the waveform show exactly how the audio files are currently distributed across the

slides. Presenter lets you import or create an audio file and then distribute that audio file across multiple slides.
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Change how audio files are distributed across slides

❖ In the Audio Editor, click a slide divider at the top of a red slide marker line and slide the divider to the left or right.

Dragging slide divider to set where audio begins or ends for a specific slide

The waveform remains static, but you can change where the audio file begins to play within the presentation. This

option is particularly useful if you have a long audio file and need to experiment with assigning the file to one slide

or having it play over multiple slides.

Listen to an audio file

❖ In the Audio Editor, click a location within the waveform and then click Play in the lower-left corner of the Audio

Editor dialog box or press the spacebar on your keyboard.

The audio plays from the location you selected to the end of all audio in the presentation. (You can stop the playback

at any time by clicking Stop in the lower-left corner of the Audio Editor dialog box or pressing the spacebar on your

keyboard.)

Zoom in on an area of the waveform

❖ In the Audio Editor, click the waveform and then click the Zoom In  or Zoom Out icon  in the toolbar.

(Alternatively, click in the waveform and roll your mouse wheel to zoom in and out).

The scale at which you are viewing the waveform is shown in the Scale information box in the lower-right corner of

the dialog box.

After you have added audio files to your presentation, you can use the Audio Editor to cut or copy entire audio files

or portions of audio files and paste them in a new location.

Cut or copy and paste audio

❖ In the Audio Editor, select a section of an audio file directly on the waveform, click Cut or Copy, click a different

location on the waveform, and click Paste.

Delete an entire audio file or portion of an audio file

❖ In the Audio Editor, select a section of an audio file directly on the waveform and click Delete.

Set audio quality for a presentation
Because higher audio quality results in a larger file size, experiment to achieve the correct balance between quality

and file size. (The default setting is Medium.)

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.
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3 Select the Quality tab.

4 Under Audio quality, select one of the following options:

High The largest file size and highest quality audio.

Medium The best balance between file size and audio quality.

Low The smallest file size and lowest audio quality.

Publish Without Audio Removes audio files from the presentation before publishing.

5 Click Close.

Preplay audio
A quick way to listen to the audio you added to a presentation is to play the slide show directly from within the Audio

Editor.

1 In PowerPoint, open a presentation (PPT file) containing audio files.

2 From the Adobe Presenter menu, select Audio Editor

3 From the View menu, select Slide Show.

4 When you finish, click Close.

Adding quizzes and questions

Creating quizzes and questions
You can use Adobe Presenter to create interactive e-learning presentations that are SCORM or AICC compliant for

use with a learning management system.When you create e-learning content for presentations, you can create a

combination of quizzes and questions.

Quizzes are the “containers” that hold questions. You can use the Quiz Manager to create a single quiz for a presen-

tation or multiple quizzes in a single presentation. Then you add questions to the quiz or quizzes. You can add graded

questions, survey questions, or a combination of both to each quiz. Quizzes are assigned an Objective ID, a number

that specifies an objective set in your learning management system or Connect Enterprise Server. Using quizzes and

their default Objective IDs is the best way to coordinate Presenter presentations with Connect Enterprise Server and

content that already exists.
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The Quiz Manager lets you organize all of the quizzes and questions in a presentation.
A. A quiz B. Different types of questions

When you create a question, a new slide is added to your presentation. The new slide’s design is based on the master

slide template (a PowerPoint feature), so the question slide will look like the other slides in your presentation.

You can design six types of questions in Presenter: multiple-choice, short-answer, matching, true-or-false, rating

scale (Likert), and fill-in-the-blank questions. You can grade the questions or use them in surveys to gather infor-

mation.

Branching in quizzes

Branching is an important concept in creating effective e-learning materials and a useful way to customize presen-

tations. In branched presentations (sometimes called “contingency branching”), the path that users take through a

quiz or survey is determined by their responses to questions. For instance, you can create branches based on correct

answers, incorrect answers, options selected by the user, or the users’s experience, job description, level, or any other

category. Depending on these factors, you can continue the presentation, jump to a specific slide, open a URL, and

so on.

Through branching, you can specify what happens when users answer questions correctly or incorrectly. For

example, you can associate one action (such as “Go to the next slide”) to a correct answer and another (such as “Open

URL”) to an incorrect answer.

Reporting

Reporting lets you track student performance with any type of quiz. You can track the number of attempts, log

correct and incorrect responses, and send pass/fail data to Connect Enterprise Server. You can also choose to provide

students with feedback based upon correct or incorrect responses.

A

B
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Tips for creating quizzes and questions

Here are a few tricks and tips to try when adding quizzes to your presentation:

• When creating a matching question, drag items between the two columns to establish the correct matches.

• Try customizing feedback messages to accurately communicate with presentation users.

• Experiment with branching to customize presentations for different types of users.

• Consider adding custom audio feedback based on how users answer questions. You can select different audio for

a correct answer and an incorrect answer.

• Try editing the settings in the Show Score at End of Quiz option. You can write custom pass and fail messages,

design the slide using background colors, and choose how to display the score.

• Always create questions in the Quiz Manager. For example, while in PowerPoint, do not copy a quiz slide in the

left pane and paste to create a “new” quiz slide. This results in two slides with the same interaction ID, which is

not supported by learning management systems.

• If a change is made in the question by editing the slide contents, open the Quiz Manager once before publishing

the presentation. Quiz validation and updating is done only when the Quiz Manager is opened.

• Change the text formatting of quiz questions after the entire quiz is generated. For example, you can create and

generate the quiz, and then use the PowerPoint Format menu to change the font size. If question text is formatted

and then the Quiz Manager is opened, the formatting may be lost because the Quiz Manager usually renders the

question again if there have been any changes.

Create a quiz
When you open the Quiz Manager for the first time, a default quiz is displayed. You can use the default quiz or add

more quizzes as necessary. Follow these steps to add a quiz:

Note: If you are creating a quiz that consists of only survey questions, the user has only one chance to take the quiz. Try

to keep the length of survey-only quizzes fairly short, for example, 15-20 questions, so users can complete the survey

easily.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager. (If this is a new presentation, you must save it first before

you can add a quiz.)

3 In the Quiz Manager, click Add New Quiz.

If you are using Microsoft Office XP, the quiz is generated after the first slide in the presentation. For presentations

made with versions of Microsoft Office other than XP, the first quiz is created after the first selected slide in the

PowerPoint Slide tab. In all versions of Microsoft Office, quizzes created after a first quiz are placed directly after the

first quiz.

Once quiz slides exist, you can drag the slides in the PowerPoint Slide tab to other locations in the presentation.

(When moving quiz slides, check that the entire quiz is moved; moving a question slide from one quiz to another

quiz is not supported.)

4 In the New Quiz dialog box, accept the default name or enter a new name in the Name text box.

5 From the pop-up menu next to Required, select an option to determine if users must take or pass the quiz. When

selecting an option, consider how the quiz fits in with your e-learning strategy for the presentation. For example, you

can require users to pass the quiz or allow them to skip the quiz.

Optional The learner may attempt the quiz, but is not required to take the quiz.



ADOBE PRESENTER 6
User Guide

35

Required The learner is required to at least attempt the quiz. A quiz attempt is defined as answering (selecting or

typing an answer and pressing Submit) at least 1 question in the quiz. Simply viewing a question is not considered

an attempt. Until the learners answer at least 1 question in the quiz, they are not permitted to move forward in the

presentation beyond the last question slide in that quiz. The required option does not, however, limit the learner

from navigating among slides within a given quiz.

Pass Required The learner must pass this quiz to continue. If you select this option, all navigation to any slide past

the end of the quiz is prohibited until the learner achieves a passing score. This restriction affects both learner-

initiated navigation (for example, clicking forward or back buttons on the playbar or clicking on a slide in the Outline

pane), and author-initiated branching (for example, immediate question and quiz feedback). If you select the Pass

Required option, you must show a scoring slide. The scoring slide tells learners why they cannot move past the quiz.

If no scoring slide is chosen, the Pass Required option behaves the same as Optional and no navigation restrictions

exist.

Answer All The learner must answer every question. The questions must be answered in order and no questions can

be skipped.

6 Select the options you want to incorporate into the quiz:

Allow backward movement (Optional) Enables learners to click the Back button on the playbar to move backward.

If you leave this option unchecked, learners cannot move backward when taking a quiz. (This prevents learners from

seeing quiz questions and then going back to earlier slides to look up correct answers.)

Allow user to review quiz (Optional) Displays a Review Quiz button on the scoring slide. Learners can click the

button and be taken back to the first question slide in the quiz. The learner can see their answer to each question,

whether their answer is correct, and, if the selected answer was not correct, which is the correct answer. Reviewing

a quiz is strictly informational; learners cannot change their answers while reviewing.

Show score at end of quiz (Optional) Displays a scoring slide at the end of the quiz. You can write custom pass and

fail messages, design the slide using background colors, and choose how to display the score.

Show questions in outline (Optional) Displays the name of the question slide in the outline when users see the

presentation in the Presenter viewer.

7 Click the Pass or Fail Options tab.

8 Select an option in the Pass/Fail scoring area. Specify a passing score either as a percentage (for instance, 80%

correct) or a number of correct answers (for instance, 8 out of 10).

9 Select the actions that take place when users receive a passing grade or a failing grade. For example, use the pop-up

menu next to Action and select Go To Slide to display a specific slide in response to passing or failing.

10 Click OK.

The quiz is added to the presentation.

Note: If you are using the “allow backward movement” option, it is important to set the correct answering options. If

“allow backward movement” is not selected (unchecked), set the Quiz Options to “answer all” and set the number of

allowable quiz attempts to 1. If a quiz is set to any option other than “answer all,” select (check) the “allow backward

movement” option. This prevents the situation where, if a learner is allowed to skip over a question, and the “allow

backward movement” option is not selected, the learner cannot go back and answer questions they may have skipped. In

most cases it is better to not select the “allow backward movement” option.

11 Click OK again.
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See also

“Preview a presentation” on page 10

Add questions to presentations
In Presenter, you can add six different types of questions to presentations. Each type of question contains different

options. Click the links below for details about adding each of the six types.

See also

“Add a fill-in-the-blank question to a presentation” on page 40

“Add a matching question to a presentation” on page 45

“Add a multiple-choice question to a presentation” on page 36

“Add a rating scale question to a presentation” on page 47

“Add a short-answer question to a presentation” on page 43

“Add a true-or-false question to a presentation” on page 38

Add a multiple-choice question to a presentation
In Presenter, you can have multiple-choice questions branch according to the user’s response. For example, in a

question with three possible answers, you can set up branching in this way: If the user selects the first answer, go to

the next slide; if the second, jump to a slide later in the quiz; if the third, open a web page.

1 In PowerPoint, open a presentation (PPT file).

2 Select the slide before the one in which you want to insert a question. For example, if you want the new question

to be slide 7 in the presentation, click slide 6.

3 From the Adobe Presenter menu, select Quiz Manager.

4 Select the quiz to which you want to add a question and click Add New Question.

5 In the Question Types dialog box, select Multiple Choice and specify whether to grade the question:

Create Graded Question The question will be graded.

Create Survey Question The question will not be graded.

6 On the Question tab, accept the default text for the name or enter a new name in the Name text box. The name

appears on the question slide in the presentation.

If you are creating more than one question of the same type (for example, multiple-choice, short answer, etc.) in a

single presentation, type a unique name for each so that you distinguish between them.

7 In the Question text box, type the multiple-choice question exactly as you want it to appear on the slide. (The

question text box cannot be left blank.)

8 In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this

question. Assigning points signifies the relative importance of a question. By assigning different point values to

different questions, you can give introductory questions a lower value than advanced questions, for example. You can

enter any whole number value. If all questions have the same value (for example, 10 points), they are scored equally.

9 In the Answers area, click Add and enter possible answers. (A multiple-choice question requires at least 2

answers.) If necessary, click Delete to remove an answer from the list.
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10 (Optional) Click Advanced to set options for individual answers, such as a custom feedback message, a specific

action, or audio. (If you have a particularly long answer, the Advanced Answer Options dialog box gives you more

space to type in the answer.)

11 Select the radio button next to the correct answer.

12 In the Type pop-up menu, select whether there are multiple correct responses or a single correct response. If you

select multiple correct responses, be sure to return to step 11 and select the radio buttons next to all correct

responses. Also, the Advanced features described in step 10 are enabled only if you select single correct response.

13 In Numbering, use the pop-up menu to specify how answers are listed on the slide. You can choose from

uppercase letters, lowercase letters, or numbers.

14 Select the Options tab.

15 (Optional) From the Type pop-up menu, select question type: Graded or Survey.

16 Select Show Clear Button to display a button on the question slide that users can click to clear their answers and

start over.

17 In the If Correct Answer area, set the following options:

Action Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide,

the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If

you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go To Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already

recorded audio, a Play button replaces the Record button. To re-record audio, you must first remove the audio, and

then select Record.)

Note: If a question has an audio clip and an action, the audio clip plays before the action takes place.

Show Correct Message Select this option to provide a text message for users when they supply a correct answer.

Clear this check box if you don’t want to give any feedback for a correct answer.

18 In the If Wrong Answer area, set the following options:

Allow User [#] Attempts Use the arrows or type directly into the text box to specify how many guesses the user can

make before another action takes place. An attempt is defined as anytime a user opens and views the question slide.

(Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts

to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an

archive.)

Infinite attempts Select this option to give users an unlimited number of attempts.

Action Click the desired action/destination after the last attempt. You can advance to the next slide (Go To Next

Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL).

In the Open URL text box, type the address of the web page and then specify where to display the web page (choose

Current to have the web page replace the presentation or New to display the web page in another window).

Go to Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.
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Show Error Message Select this option to provide a text message for users when they supply an incorrect answer.

Clear this check box if you don’t want to give any feedback for an incorrect answer.

Show Retry Message Select this option to provide a text message for users who give an incorrect answer but have

remaining attempts (for instance, “Please try again”).

Show Incomplete Message Select this option to provide a text message for users who don’t supply an answer (for

instance, “Please select an answer before continuing”).

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the

Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

19 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

Report Answers Sends answer information to Connect Enterprise Server or a learning management system.

Quiz Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

Objective ID This is a number automatically created when you create a quiz. This number is used to report scores

from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

Interaction ID Accept the default number or type a new number directly into the text box. The maximum length of

an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect

Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Inter-

action ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend

creating new questions by copying and pasting; always create new questions using the Quiz Manager.

20 When you finish, click OK.

21 Click OK again to close the Quiz Manager.

The new multiple-choice question slide appears in the designated location in the presentation.

Add a true-or-false question to a presentation
Users answer true-or-false questions by selecting either True or False (or Yes or No) as an answer.

1 In PowerPoint, open a presentation (PPT file).

2 Select the slide before the one where you want to insert a question. For example, if you want the new question slide

to be slide 7 in the presentation, click slide 6.

3 From the Adobe Presenter menu, select Quiz Manager.

4 Select the quiz to which you want to add a question and click Add New Question.

5 In the Question Types dialog box, select True/False and specify whether the question will be graded:

Create Graded Question The question will be graded.

Create Survey Question The question will not be graded.

6 On the Question tab, accept the default text for the name or enter a new name in the Name text box. The name

appears on the question slide in the presentation.

If you are creating more than one question of the same type (for example, multiple-choice, short answer, etc.) in a

single presentation, type a unique name for each so that you distinguish between them.

7 In the Question text box, type the true-or-false question exactly as you want it to appear on the slide. (The

question text box cannot be left blank.)
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8 In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this

question. Assigning points signifies the relative importance of a question. Assigning different point values to

different questions lets you, for example, give introductory questions a lower value and advanced questions a higher

value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are

scored equally.

9 In the Answers area, establish which answer is correct by selecting either True or False.

10 In the Type pop-up menu, select True or False, or Yes or No. You can also write your own phrases to use such as

“Valid” and “Invalid.”

11 In Numbering, use the pop-up menu to select an option for how answers are listed on the quiz slide. You can

choose from uppercase letters, lowercase letters, or numbers.

12 Select the Options tab.

13 (Optional) From the Type pop-up menu, select the question type: Graded or Survey.

14 Select Show Clear Button to insert a button on the slide that users can click to clear their answers and start over.

15 In the If Correct Answer area, set the following options:

Action Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide,

the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If

you display a web page, type its address in the open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go to Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already

recorded audio, a Play button replaces the Record button. To re-record audio, you must first remove the audio, and

then select Record.)

Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

Show Correct Message Select this option to provide a text message for users when they supply a correct answer.

Clear this check box if you don’t want to give any feedback for a correct answer.

16 In the If Wrong Answer area, set the following options:

Allow User [#] Attempts Use the arrows or type directly into the text box to specify how many guesses the user can

make before another action takes place. An attempt is defined as anytime a user opens and views the question slide.

(Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts

to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an

archive.)

Infinite Attempts Select this option to give users an unlimited number of attempts.

Action Click the desired action/destination after the last attempt. You can advance to the next slide (Go To Next

Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL).

If you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go to Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.
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Show Error Message Select this option to provide a text message for users when they supply an incorrect answer.

Clear this check box if you don’t want to give any feedback for an incorrect answer.

Show Retry Message Select this option to provide a text message for users who give an incorrect answer but have

remaining attempts (for example, “Please try again”).

Show Incomplete Message Select this option to provide a text message for users who don’t supply an answer (for

example, “Please select an answer before continuing”).

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the

Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

17 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

Report Answers This option sends answer information to Connect Enterprise Server or a learning management

system.

Quiz Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

Objective ID This is a number automatically created when you create a quiz. This number is used to report scores

from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

Interaction ID Accept the default number or type a new number directly into the text box. The maximum length of

an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect

Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Inter-

action ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend

creating new questions by copying and pasting; always create new questions using the Quiz Manager.

18 When you finish, click OK.

19 Click OK again to close the Quiz Manager.

The new true-or-false question slide appears in the designated location in the presentation.

Add a fill-in-the-blank question to a presentation
Fill-in-the-blank questions contain a blank space that users fill in by entering text (such as a word or phrase) or

selecting from a list of possible answers.

1 In PowerPoint, open a presentation (PPT file).

2 Select the slide before the one where you want to insert a question. For example, if you want the new question slide

to be slide 7 in the presentation, click slide 6.

3 From the Adobe Presenter menu, select Quiz Manager.

4 Select the quiz to which you want to add a question and click Add New Question.

5 In the Question Types dialog box, select Fill-in-the-blank and specify whether to grade the question:

Create Graded Question The question will be graded.

Create Survey Question The question will not be graded.

6 On the Question tab, accept the default text for the name or enter a new name in the Name text box. The name

appears on the question slide in the presentation.

If you are creating more than one question of the same type (for example, multiple-choice and short answer) in a

single presentation, type a unique name for each so that you distinguish between them.
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7 In the Description text box, accept the default text for Description or enter a new description. The description

appears on the questions slide in the presentation and should give users instructions about how to answer the

question. (The Description field cannot be left blank.)

8 In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this

question. Assigning points signifies the relative importance of a question. Assigning different point values to

different questions lets you, for example, give introductory questions a lower value and advanced questions a higher

value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are

scored equally.

9 In the Phrase text box, type in the entire sentence or phrase that will contain a blank space to be completed by

users or will contain a blank space with a drop-down list of possible answers for users to select from.

10 Select the word or phrase that you intend to be the blank area and click Add Blank. You can have a maximum of

8 blanks in a question. (When a blank is created, the blank is represented by “<i>” in the dialog box with the “i” repre-

senting the number assigned to the blank. Do not edit the text ”<i>” manually. Use the Add blank and Delete blanks

buttons to achieve the desired results.)

11 In the Blank Answer dialog box, specify how users will choose the correct answer:

The User Will Type in the Answer, Which Will Be Compared to the List Below Users type an answer in a text box.

The User Will Select an Answer from the List Below Users select an answer from a drop-down list. (The drop-down

list can display answers approximately 22 characters in length. Answers longer than 22 characters may not be fully

visible in the published output.)

12 If necessary, click Add and enter more words or phrases that correctly fill in the blank space in the question. Click

Add and Delete as necessary to create a list of correct answers.

13 (Optional) Select The answer is case-sensitive to require that users type in the correct combination of lowercase

and uppercase letters when filling in the blank. For example, if the answer to the question is “Windows” and you

select the case-sensitive option, an answer of “windows” is incorrect.

14 Click OK.

15 Select the Options tab.

16 (Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.

17 Select Show Clear Button to display a button on the question slide that users can click to clear their answers and

start over.

18 In the If Correct Answer area, set the following options:

Action Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide,

the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If

you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go To Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already

recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and

then select Record.)

Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

Show Correct Message Select this option to provide a text message for users when they supply a correct answer.

Clear this check box if you don’t want to give any feedback for a correct answer.
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19 In the If Wrong Answer area, set the following options:

Allow User [#] Attempts Use the arrows or type directly into the text box to specify how many guesses the user can

make before another action takes place. An attempt is defined as anytime a user opens and views the question slide.

(Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts

to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an

archive.)

Infinite Attempts Select this option to give users an unlimited number of attempts.

Action Click the desired action/destination after the last attempt. You can advance to the next slide (Go To Next

Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL).

If you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go To Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

Show Error Message Select this option to provide a text message for users when they supply an incorrect answer.

Clear this check box if you don’t want to give any feedback for an incorrect answer.

Show Retry Message Select this option to provide a text message for users when they supply an incorrect answer but

there are remaining attempts available (for example, Please try again).

Show Incomplete Message Select this option to provide a text message for users who don’t supply an answer (for

instance, “Please select an answer before continuing”).

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the

Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

20 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

Report Answers This option sends answer information to Connect Enterprise Server or a learning management

system.

Quiz Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

Objective ID This is a number automatically created when you create a quiz. This number is used to report scores

from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

Interaction ID Accept the default number or type a new number directly into the text box. The maximum length of

an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect

Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Inter-

action ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend

creating new questions by copying and pasting; always create new questions using the Quiz Manager.

21 When you finish, click OK.

22 Click OK again to close the Quiz Manager.

The new fill-in-the-blank question slide appears in the designated location in the presentation.
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Add a short-answer question to a presentation
Users answer short-answer questions by providing a word, phrase, or complete sentence as an answer. You can also

use this as an essay question and grade it or gather extended feedback as a survey question.

1 In PowerPoint, open a presentation (PPT file).

2 Select the slide before the one where you want to insert a question. For example, if you want the new question slide

to be slide 7 in the presentation, click slide 6.

3 From the Adobe Presenter menu, select Quiz Manager.

4 Select the quiz to which you want to add a question and click Add New Question.

5 In the Question Types dialog box, select Short Answer and specify whether to grade the question:

Create Graded Question The question will be graded.

Create Survey Question The question will not be graded.

6 On the Question tab, accept the default text for Name or type a new name directly into the text box. The name

appears on the question slide in the presentation.

If you are creating more than one question of the same type (for example, multiple-choice and short answer) in a

single presentation, type a unique name for each so that you distinguish between them.

7 In the Question text box, type the short-answer question, exactly as you want it to appear on the slide. (The

question text box cannot be left blank.)

8 In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this

question. Assigning points signifies the relative importance of a question. Assigning different point values to

different questions lets you, for example, give introductory questions a lower value and advanced questions a higher

value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are

scored equally.

9 In the Acceptable Answers area, click an empty row or click Add and enter words or phrases that are correct

answers to the question. Click Add and Delete as necessary to write an appropriate list.

10 (Optional) Select The answer Is Case-sensitive to require that users type in the correct combination of lowercase

and uppercase letters when providing a short answer. For example, if the answer to the question is Windows and you

select the case-sensitive option, an answer of windows would be incorrect.

11 Select the Options tab.

12 (Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.

13 Select Show clear button to display a button on the question slide that users can click to clear their answers and

start over.

14 In the If Correct Answer area, set the following options:

Action Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide,

the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If

you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go To Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already

recorded audio, a Play button replaces the Record button. To re-record audio, you must first remove the audio, and

then select Record.)
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Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

Show Correct Message Select this option to provide a text message for users when they supply a correct answer.

Clear this check box if you don’t want to give any feedback for a correct answer.

15 In the If Wrong Answer area, set the following options:

Allow User [#] Attempts Use the arrows or type directly into the text box to specify how many guesses the user can

make before another action takes place. An attempt is defined as anytime a user opens and views the question slide.

(Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts

to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an

archive.)

Infinite Attempts Select this option to give users an unlimited number of attempts.

Action Click the desired action/destination after the last attempt. You can advance to the next slide (Go To Next

Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL).

If you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go To Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

Show Error Message Select this option to provide a text message for users when they supply an incorrect answer.

Clear this check box if you don’t want to give any feedback for an incorrect answer.

Show Retry Message Select this option to provide a text message for users when they supply an incorrect answer but

there are remaining attempts available (for example, Please try again).

Show Incomplete Message Select this option to provide a text message for users who don’t supply an answer (for

instance, “Please select an answer before continuing”).

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the

Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

16 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

Report Answers This option sends answer information to Connect Enterprise Server or a learning management

system.

Quiz Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

Objective ID This is a number automatically created when you create a quiz. This number is used to report scores

from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

Interaction ID Accept the default number or type a new number directly into the text box. The maximum length of

an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect

Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Inter-

action ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend

creating new questions by copying and pasting; always create new questions using the Quiz Manager.

17 When you finish, click OK.

18 Click OK again to close the Quiz Manager.
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The new short-answer question slide appears in the designated location in the presentation. If you are using the

short-answer question as a graded essay question, you can grade the answer using the Connect Enterprise Manager

override option. For more information, see the Connect Enterprise Manager User Guide.

Add a matching question to a presentation
Users answer matching questions by matching items in two different lists.

1 In PowerPoint, open a presentation (PPT file).

2 Select the slide before the one where you want to insert a question. For example, if you want the new question slide

to be slide 7 in the presentation, click slide 6.

3 From the Adobe Presenter menu, select Quiz Manager.

4 Select the quiz to which you want to add a question and click Add New Question.

5 In the Question Types dialog box, select Matching and specify whether to grade the question:

Create Graded Question The question will be graded.

Create Survey Question The question will not be graded.

6 On the Question tab, accept the default text for the Name or type new text directly into the text box. The name

appears on the question slide in the presentation.

If you are creating more than one question of the same type (for example, multiple-choice and short answer) in a

single presentation, type a unique name for each so that you distinguish between them.

7 In the Question text box, type the matching question, exactly as you want it to appear on the slide. For example,

“Match the job titles in column 1 with the correct departments in column 2.” (The question text box cannot be left

blank.)

8 In the Points text box, type in (or use the up and down arrows to specify) the number of points allocated to this

question. Assigning points signifies the relative importance of a question. Assigning different point values to

different questions lets you, for example, give introductory questions a lower value and advanced questions a higher

value. You can enter any whole number value. If all questions have the same value (for example, 10 points), they are

scored equally.

9 In Answers, click Add under each column and type in the words or phrases to match. (You can also click directly

in each column to type in words or phrases.) If necessary, click Delete to remove any answers or click the up and

down arrows to move answers up or down a position in the column.

10 (Optional) To change the names of the columns, click the default names (“Column 1” and “Column 2”) and type

in new names.

11 To establish the correct matches between answers, click an item in one column, then click an item in the other

column, and click Match. (You can also drag items between the two columns to create correct matches.) A line is

drawn between the two items to show the relationship. All items in Column 1 must have a match in Column 2.

12 If you need to change the order of items in a column, select an item and then click the up or down arrow below

the column to move the item up or down in the list.

13 If you make an error while establishing the correct matches between column items, click Clear matches and start over.

14 In Numbering, use the pop-up menu and select an option for how answers are listed on the quiz slide. You can

choose from uppercase letters, lowercase letters, or numbers.

15 Select the Options tab.

16 (Optional) In Type, use the pop-up menu to change the question type to Graded or Survey.
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17 Select Show Clear Button to display a button on the question slide that users can click to clear their answers and

start over.

18 In the If Correct Answer area, set the following options:

Action Select which action should follow a correct response. You can advance to the next slide (Go To Next Slide,

the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL). If

you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go To Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered correctly. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already

recorded audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and

then select Record.)

Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

Show Correct Message Select this option to provide a text message for users when they supply a correct answer.

Clear this check box if you don’t want to give any feedback for a correct answer.

19 In the If Wrong Answer area, set the following options:

Allow User [#] Attempts Use the arrows or type directly into the text box to specify how many guesses the user can

make before another action takes place. An attempt is defined as anytime a user opens and views the question slide.

(Setting the number of attempts to 1 prevents the presentation from proceeding if the user exits and then attempts

to enter the quiz again. Do not set attempts to 1 if you plan to use your presentation in a meeting or place in an

archive.)

Infinite Attempts Select this option to give users an unlimited number of attempts.

Action Select the desired action/destination after the last attempt. You can advance to the next slide (Go To Next

Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL).

If you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go To Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered incorrectly. Use the Record, Stop, Remove, and Import buttons as necessary.

Show Error Message Select this option to provide a text message for users when they supply an incorrect answer.

Clear this check box if you don’t want to give any feedback for an incorrect answer.

Show Retry Message Select this option to provide a text message for users when they supply an incorrect answer but

there are remaining attempts available (for example, Please try again).

Show Incomplete Message Select this option to provide a text message for users who don’t supply an answer (for

instance, “Please select an answer before continuing”).

Note: You can edit the default text in the correct, error, retry, and incomplete messages in the Quiz Manager. From the

Adobe Presenter menu, select Quiz Manager and click the Default Labels tab.

20 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

Report Answers This option sends answer information to Connect Enterprise Server or a learning management

system.

Quiz Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.
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Objective ID This is a number automatically created when you create a quiz. This number is used to report scores

from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

Interaction ID Accept the default number or type a new number directly into the text box. The maximum length of

an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect

Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Inter-

action ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend

creating new questions by copying and pasting; always create new questions using the Quiz Manager.

21 When you finish, click OK.

22 Click OK again to close the Quiz Manager.

The new matching question slide appears in the designated location in the presentation.

Add a rating scale question to a presentation
Users answer rating scale questions by specifying their level of agreement to a statement. For example, a user may be

given the question, “This presentation provided me with valuable information.” and asked if they disagree, somewhat

disagree, are neutral, somewhat agree, or agree.

Rating scale questions are always survey questions and are therefore not graded. You cannot assign a rating scale

question with a point value, nor can you creating branching for a correct or incorrect answer (since it’s a survey

question and does not have a correct or incorrect answer). You can, however, decide what happens after the user

completes the rating scale question, such as continuing to the next slide or displaying a URL.

1 In PowerPoint, open a presentation (PPT file).

2 Select the slide before the one where you want to insert a question slide. For example, if you want the new question

slide to be slide 7 in the presentation, click slide 6.

3 From the Adobe Presenter menu, select Quiz Manager.

4 Select the quiz to which you want to add a question and click Add New Question.

5 In the Question Types dialog box, select Rating Scale (Likert).

6 Click Create Survey Question.

7 On the Question tab, accept the default text for the Name or type new text directly into the text box. The name

appears on the question slide in the presentation.

If you are creating more than one question of the same type (for example, multiple-choice and short answer) in a

single presentation, type a unique name for each so that you distinguish between them.

8 Accept the default text for Description or type a new description directly into the text box. The description

appears on the question slide in the presentation and should provide users with instructions about how to answer

the question. (The description text box cannot be left blank.)

9 In the Questions area, click in the first row or click Add and type a Likert question directly into the text box. (You

can add up to five separate Likert questions on a single slide.)

10 In the Answers area, you can accept the default answer text, edit the text, delete a type, and add a new answer

types. To edit the text, double-click existing text such as “Neutral” and type new text. To delete an answer type, select

a type and click Delete. To add an answer type, click Add and type new text. (You can have a total of five answer

types.)

11 Select the Options tab.
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12 Select Show clear button to display a button on the question slide that users can click to clear their answers and

start over.

13 In the After Survey question area, set the following options:

Action Click the desired action/destination after the survey is taken. You can advance to the next slide (Go To Next

Slide, the default action), jump to another slide in the presentation (Go To Slide), or display a web page (Open URL).

If you display a web page, type its address in the Open URL text box and then specify where to display the web page

(choose Current to have the web page replace the presentation or New to display the web page in another window).

Go to Next Slide Depending on the option you selected for Action, this text box lets you specify an exact destination.

Play Audio Clip Select this option to import an audio file or record a new audio file that should play when the

question is answered. Use the Record, Stop, Remove, and Import buttons as necessary. (If you have already recorded

audio, the record button will be a Play button. To re-record audio, you must first remove the audio, and then select

Record.)

Note: If a question has an audio clip and an action, the audio clip plays and then the specified action takes place.

14 Select the Reporting tab. You can accept the default settings or, if necessary, modify the following options:

Report Answers This option sends answer information to Connect Enterprise Server or a learning management

system.

Quiz Name of the quiz to which this question is assigned. You can select a different quiz from the pop-up menu.

Objective ID This is a number automatically created when you create a quiz. This number is used to report scores

from Presenter presentations that will be tracked in Connect Enterprise Server or a learning management system.

Interaction ID Accept the default number or type a new number directly into the text box. The maximum length of

an interaction ID is 64 characters. If you want the Presenter presentation to send tracking information to Connect

Enterprise Server, you must use the Interaction ID specified by Connect Enterprise Server.

Note: If you create a new question by copying and pasting an existing question slide, you must enter a new, unique, Inter-

action ID so that each individual question is reported properly to Connect Enterprise Server. We do not recommend

creating new questions by copying and pasting; always create new questions using the Quiz Manager.

15 When you finish, click OK.

16 Click OK again to close the Quiz Manager.

The new rating scale question slide appears in the designated location in the presentation.

Edit quizzes and questions
After you have created question slides in a presentation, you can edit them as required.

See also

“Preview a presentation” on page 10

Change question slide order

After you have created question slides in a presentation, you can change their order. The easiest method is to move

the slides in PowerPoint.

1 In PowerPoint, open a presentation (PPT file).

2 In the Outline pane, drag the slide icon to a new location.
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The next time you open the Quiz Manager (from the Adobe Presenter menu), the new question order is displayed.

Delete a question slide

You can delete a question slide at any time. The easiest method is to delete the slide in PowerPoint.

1 In PowerPoint, open a presentation (PPT file).

2 In the Outline pane, select a slide and click Delete.

The next time you open the Quiz Manager (from the Adobe Presenter menu), the question slide will not be listed.

Add a feedback message to a question

Because quizzes are interactive, it’s important to guide users through any question slides you place in projects. An

easy way to communicate with users is through feedback messages. These are messages that display, for example,

when a user selects a correct answer or incorrect answer. Feedback messages are set for individual questions, so you

can choose to include messages in some questions or all questions within a quiz.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 Select a question and click Edit Question.

4 Click the Options tab.

5 In the If Correct Answer area, select the Show Correct Message option to display a message for users confirming

that they selected the correct answer. Deselect the Show Correct Message option if you do not want to display a

message for users when they select the correct answer.

6 In the If Wrong Answer area, select the Show Error Message option to display a message for users stating that they

selected the incorrect answer. Deselect the Show Error Message option if you do not want to display a message for

users when they select the incorrect answer.

7 In the If Wrong Answer area, select the Show Retry Message option to display a message for users when they select

the incorrect answer, but have remaining answer attempts available. Deselect the Show Retry Message option if you

do not want to display a message for users when they select the incorrect answer, but have remaining answer attempts

available.

8 In the If Wrong Answer area, select the Show Incomplete Message option to display a message to users who do

not supply an answer to a required question.

Click OK two times to close all of the dialog boxes.

Edit feedback message text in a quiz

Presenter provides default text for feedback messages that are displayed for users, but you can edit the text at any

time. The text is set at the quiz level so that all questions within a quiz display the same feedback messages.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 On any quiz, click Edit Quiz Settings.

4 Select the Allow User to Review Quiz option and click Question Review Messages.

5 Accept the default text or type new text directly into the text boxes for Correct, Incomplete, and Incorrect

feedback messages.

6 Click OK three times to close all of the dialog boxes.



ADOBE PRESENTER 6
User Guide

50

Note: If you change the default labels, the question feedback messages also change for questions that have already been

created.

Change default labels

You can change the default labels on question buttons and question feedback messages. This is an easy way to

customize communications with users taking quizzes.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 Click Default Labels.

4 Under Default question button labels, change any of the following options:

Submit button text Enter the text that should appear on the question Submit button. (For example, you could

change the text to OK or Enter.)

Clear button text Enter the text that should appear on the question Clear button. (For example, you could change

the text to Start Over or Restart.)

5 Under Default question feedback, change any of the following options:

Correct message Enter the text message that should appear when users select the correct answer.

Incorrect message Enter the text message that should appear when users select an incorrect answer.

Retry message Enter the text message that should appear if users enter an incorrect answer and they have more

question attempts available.

Incomplete message Enter the text message that should appear if users fail to answer a required question.

6 Click OK.

Set reporting options
Presenter offers output options for presentations with e-learning elements. For example, you can create presentations

that are SCORM or AICC compliant for use within a learning management system.

Reporting options such as what kind of data to collect and how the data is reported are set for a quiz. You can,

however, select whether to report interaction data to a learning management system at the quiz level or the question

level. If the two settings are different, the setting for the question is used. For example, a quiz is set to report interac-

tions, but a question within the quiz is not set to report interactions. In this case, the question does not get reported.

The question will, however, be included in the overall numerical score for the quiz if the question is a graded

question. (Because the question was not set to report interactions, the exact answer the user selected does not get

reported.)

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 In the Quiz Manager dialog box, select a quiz and click the Reporting tab.

4 Select Enable Reporting for This Presentation.

5 Select the main learning management system standard you want to use:

• Connect Enterprise Server

• AICC. If you select AICC, four course structure files are created.
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• SCORM. If you select SCORM, click Manifest to set options for creating a manifest file, required by many third-

party learning management systems.

6 Choose how to report data:

Report to Connect Enterprise Server Reports quiz reporting data to the Connect Enterprise Server. For example, in

a presentation containing quizzes, a passing grade is reported to Connect Enterprise Server if all questions in all

quizzes were answered completely and the user achieved a passing score. Or, if a presentation does not contain

quizzes, a grade of complete is sent to Connect Enterprise Server when the user has viewed all slides.

Report Quiz Results Only Reports quiz results only in the presentation itself. (No data will be sent to a learning

management system.) For example, if a presentation contains quizzes, and any quiz is assigned a passing score that

is greater than 0, when a user completes all quizzes with a passing score, a passing grade is reported. Or, if a presen-

tation does not contain quizzes, a grade of complete is reported when the user has viewed all slides.

Report User Access Only Reports if users have opened the presentation and viewed one slide.

Report Quiz Results and Slide Views Reports quiz results only in the presentation itself (no data will be sent to a

learning management system) and how many individual slides users viewed. For example, if a presentation contains

quizzes, two items are reported. First, if any quiz is assigned a passing score that is greater than 0, when a user

completes all quizzes with a passing score, a passing grade is reported. Second, a grade of complete is sent to Connect

Enterprise Server when the user has viewed all (100%) of the slides. Or, if a presentation does not contain quizzes,

send a grade of complete when the user has viewed all (100%) of the slides.

Report Slide Views Only Reports how many individual slides users viewed. The number is given as a percentage. For

example, if a user opens a presentation and views 8 out of 10 slides, a slide view of 80% is reported.

Slide View Completion % Lets you set the percentage of slides that must be viewed by a user for them to complete

the presentation. For example, if you have a presentation that contains 10 slides and you set the Slide View

Completion percentage to 80, users who view 8 out of the 10 slides will have “completed” the presentation. (This

option is only available if you select the Report Quiz Results and Slide Views or Report Slide Views Only option.)

7 Select how pass and fail information is reported. (If you selected the Report to Connect Enterprise Server option

in step 6, settings in this Report Pass or Fail area are ignored, and all information is sent to Connect Enterprise

Server.)

Report Complete/Incomplete Reports results as either complete or incomplete. Users must view every slide and, if

there are quiz slides, must take the quizzes (and receive either a passing or failing score) to receive Complete status.

Note: If you are creating a quiz that consists of only survey questions, the user has only one chance to take the quiz. Try

to keep the length of survey-only quizzes fairly short, for example, 15-20 questions, so users can complete the survey

easily.

Report Pass/Fail Reports results as either pass or fail. Users must view every slide and, if there are quiz slides, must

take the quizzes (and receive either a passing or failing score) to receive Pass status.

Report Status as Defined by Report Data Reports status using the selections made in the Choose Report Data area

of this dialog box.

8 Select how scores are reported to your learning management system. (If you selected the Report to Connect Enter-

prise Server option in step 6, settings in this Report score to LMS as area are ignored and all information is sent to

Connect Enterprise Server.)

Score Scores are reported as a numerical score. For example, 8 out of 10 correct.

Percent Scores are reported as a percentage. For example, 85% correct.
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9 Select a reporting level. (If you selected the Report to Connect Enterprise Server option in step 6, settings in this

Reporting level area are ignored and all information is sent to Connect Enterprise Server.)

Only Report the Score Only scores are reported to the learning management system.

Report Interactions and the Score Scores and interactions are reported to the learning management system.

10 (Optional) Click Settings to customize how data is sent and formatted to a learning management system.

11 Click OK.

See also

“Creating quizzes and questions” on page 32

Set a pass rate for a quiz
When you place quizzes in a presentation, you set a pass rate for users. The pass rate is a percentage or numeric value

that users must reach in order to pass the quizzes. For example, setting a pass of 80% requires users to get 80% of

questions correct in order to pass.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 In the Quiz Manager, select a quiz and click Edit Quiz Settings.

4 Click the Pass or Fail Options tab.

5 Select a Pass/Fail option:

“#” % or more of total score to pass Enter a percentage value that students must meet in order to pass. For example,

if you enter a value of 80, students must provide correct answers to 80% of the questions. (In a quiz containing 10

questions, at least 8 must be answered correctly).

“#” or more of total score to pass Enter a numeric value that students must meet in order to pass. For example, if you

enter a value of 8, students must provide correct answers to 8 questions in the quiz.

6 Click OK.

Set score display
You can set the way the quiz score is reported to users.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 In the Quiz Manager dialog box, select a quiz and click Edit Quiz Settings.

4 Click the Quiz Settings tab.

5 Select Show Score at End of Quiz.

6 Click Quiz Result Messages.

7 Select a score option:

Display Score specifies that the numerical score is displayed.

Display Percent Score specifies that a score as a percentage of total is displayed.

Tally Correct specifies that a score in tally form (for example, “7 out of 10 correct”) is displayed.
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8 Click OK three times to close all of the dialog boxes.

Use presentations with a learning management system
Presentations created with Presenter integrate especially well with the Connect Enterprise Server learning

management system (LMS), but you can use Presenter presentations with any LMS. If you are going use a presen-

tation with a third-party LMS, the following sections explain how to create a manifest file and how to customize LMS

settings.

Note: If you select the Connect Enterprise Server or AICC option when setting reporting options, four AICC course

structure files are created: presenter.au, presenter.crs, presenter.cst, and presenter.des. The files are created with default

values, but the values can be edited manually. For more information, see the AICC website at www.aicc.org.

See also

“Creating quizzes and questions” on page 32

Creating a SCORM manifest file

If you want to package a Presenter presentation as an e-learning course that can be administered and launched from

a SCORM 1.2 or 2004 conformant learning management system, you may need a manifest file.

Note: If you are publishing to Connect Enterprise Server, a manifest file is automatically created named breeze-

manifest.xml. This XML file is used to upload the presentation into the Connect Enterprise Server. You do not need to

follow the procedure below to create a SCORM manifest file.

The manifest file that Presenter creates is named imsmanifest.xml and contains references to all content resources.

The XML file uses predefined XML tags to describe the package components, structure, and special behaviors. The

file works behind the scenes to properly integrate presentations with your learning management system and track

quiz data.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 Click the Reporting tab.

4 Select Enable Reporting for This Presentation.

5 Under Learning Management System (LMS), select SCORM.

6 Click Manifest.

7 Set the SCORM Version by selecting 1.2 or 2004 from the pop-up menu.

8 Set the following manifest options:

Identifier (Required) The identifier is used by the LMS to identify different manifests. A default identifier based on

the name of your Presenter presentation is automatically added to this text box. You can change the identifier at any

time by selecting the text and typing in new text.

Title (Required) The title can be viewed by students using the LMS. A default title based on the name of your

Presenter presentation is automatically added to this text box. You can change the title at any time by selecting the

text and typing in new text.

Description (Required) Text used by the LMS to describe different courses to users. A default description based on the

name of your Presenter presentation is automatically added to this text box. You can edit the description at any time.

http://www.adobe.com/go/aicc
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Version (Optional) The version specifies a number that can be used to differentiate manifests with the same

identifier.

Duration (Optional) Select this option to specify the approximate time it takes to work with this particular Presenter

presentation. Set the time in the following format: hh:mm:ss.

Subject (Optional) Select this option to write a short description of the Presenter presentation using keywords or

phrases.

SCO Identifier (Required) The identifier is used by the LMS to identify different Shareable Content Objects (SCO).

A default identifier based on the name of your Presenter presentation is automatically added to this text box. You can

change the identifier at any time by selecting the text and typing in new text. (If you type the name of a new identifier,

do not use any spaces in the name.)

Title (Required) A default title based on the name of your Presenter presentation is automatically added to this text

box. You can change the title at any time by selecting the text and typing in new text.

Mastery Score (Optional) Select this option to specify a passing score for the Presenter presentation. The score

should be a number between 0 and 100. Only Presenter presentations containing score-reporting objects such as

quiz slides, text entry boxes, click boxes, or buttons, need to include a mastery score.

Time Allowed (Optional) Select this option to specify the maximum amount of time allowed to complete the

Presenter presentation.

Time Limit Action (Optional) Select this option to specify the action that should be taken when the maximum time

allowed to complete the presentation has been exceeded. From the pop-up menu, select one of the four options: Exit

with Message, Exit Without Message, Continue with Message, or Continue Without Message.

Launch Data (Optional) Select this option to specify initialization data expected by the resource.

9 Click OK.

To see the manifest file, you should publish your Presenter presentation locally to create a Flash SWF file and a

manifest file. If you used the default save location, you can use Windows Explorer to navigate to the SWF file and

imsmanifest.xml file in My Documents\My Presentations\Name of Presentation folder. If you published the presen-

tation to a different folder, navigate to that location to see the manifest file.

Set advanced learning management system settings

Presenter offers several advanced settings for how presentations integrate with learning management systems (LMS).

The settings let you specify what data is sent to the LMS and how the data is formatted. Typically, these settings are

used by advanced LMS users or requested by LMS administrators.

Note:The settings are used by third-party learning management systems; they do not affect the data sent from Presenter

to Connect Enterprise Server.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Quiz Manager.

3 Click the Reporting tab.

4 Click Settings.

5 In the LMS Customization Settings area, set the following options:

Never Send Resume Data Select this option if you do not want resume data to be sent to your LMS. This might be

useful if your LMS does not support resume data or another mechanism to prevent users from returning to a quiz

they started, but did not finish, across multiple sessions. For example, a user completes 4 questions out of 8 and then

closes the presentation. If you select this option, when the user opens the presentation again they must provide
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answers to all 8 questions—their answers from the first session are not remembered in the Presenter presentation.

This option can be used when publishing and playing back content from any AICC or SCORM compliant learning

management system.

Note: Presentations that are part of a Connect Enterprise Server training course or curriculum are always automatically

resumed. If the presentation is viewed using the Content tab, it is never resumed.

Escape Version and Session ID This option is selected by default. Keep this option selected if you want Presenter to

URL-encode (escape) the version and session ID when sending data to an AICC compliant learning management

system. This is useful if your learning management system does not accept URL-encoded information for these

fields. Deselect this option if you do not want to URL-encode (escape) the version and session ID.

Don’t Escape Characters This option lets you specify that Presenter should not URL-encode (escape) the value fields

in parameters when data is sent to an AICC compliant learning management system. In the text box, type in the

characters (without any delimiters such as spaces or commas) that the learning management system does not want

escaped. For example, if the LMS does not want any numbers escaped, type in 0123456789.

Send Interval This option lets you specify how often slide data should be sent to the LMS. As a user views a presen-

tation, information is sent to the LMS. For regular slides, the LMS is notified that the user viewed the slide and for

question slides, information about the user response is sent to the LMS. Also, each time any kind of slide is viewed,

the LMS records the slide number so that if a user quits and then opens the presentation later, they will return to the

last slide they viewed. If you do not want information sent to the LMS for every slide in the presentation, you can

change the Send Interval. For example, if you change the interval to 10, information will be sent to the LMS every

10 slides.

Note: If you change the Send Interval to a number higher than one, users who quit before finishing the presentation may

not be able to resume where they left off. For example, if the Send Interval is changed to 10 and a user quits after viewing

9 slides, when they open the presentation again, they start over at slide 1.

6 Click OK to finish setting the custom LMS settings and close the Quiz Manager.

Designing presentations

Create and edit themes
The primary way to design how presentations appear in the Presenter viewer is through the use of themes. Themes

serve as the “container” for your presentation, and let you add static images, colors, and sound to create dynamic and

interactive presentations. You can add a theme at any time. Try using different themes until you achieve the right

look you want. You can reuse the same theme for each presentation you create or design new themes.

Presenter gives you many options for customizing colors, tabs, functionality, graphics, font style, and other design

elements of a theme.
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Examples of customizable themes

See also

“Preview a presentation” on page 10

Select a presentation theme

The default theme assigned to presentations is Sage, but you can change the theme at any time.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.

3 From the Theme Name pop-up menu, select a theme.

The preview window displays the new theme.

4 Change theme options as desired.

5 Click OK to close the Theme Editor.

Create a custom theme

You can create a custom theme by selecting one of the default themes, making changes, and saving the new theme

with a different name. For example, you can start with the theme, Sage, change the font color to dark green, and then

save the new theme as Sage Modified. After you create a custom theme, it appears in the Theme name pop-up menu

and can be used with other presentations.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.

3 Make changes as desired. For instance, click Text Labels to change the text in different areas of the theme, or click

Change Theme Colors to select custom colors for the font and background.

4 Click the Save as button and specify a name for the new theme.

5 Click OK.

The new theme appears in the Theme Name pop-up menu in the Theme Editor and can be used when publishing

presentations.



ADOBE PRESENTER 6
User Guide

57

Change text labels in a theme

Text labels are the words that appear in a theme, such as button text and tab names. You can edit text labels in a theme

at any time.

Note: The column heading text “Slide Title” and “Duration” cannot be changed.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.

3 Click the Text Labels button.

4 Click the Language pop-up menu and select a language for the text labels.

Note: Presentations detect the language of a user’s operating system and automatically display the text labels in the user’s

native language if their computer’s language is set to German, French, Korean, or Japanese. Otherwise, English text

labels appear.

5 As necessary, change the text labels for any element of the presentation theme. For example, you can change the

text that displays on buttons or panes.

6 Click OK.

The theme preview on the right side of the Theme Editor dialog box is updated to reflect your choices.

7 Click OK.

Change theme colors

You can change the colors that appear in a theme, including the background color and glow color. You can also

specify a background image to use in a theme.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.

3 Click the Change Theme Colors button. To change a color, click once on any of the color bars. You can change any

of the following color options:

Theme Color Click this color bar to change the color of the theme sidebar and toolbar.

Glow Color Click this color bar to change the color that appears when users hover their mouse over slides in the

Outline pane and thumbnail images in the Thumb pane.

Font Color Click this color bar to change the color of the text in the theme.

Background Color Click this color bar to change the color of the background area that appears behind the slides,

sidebar, and toolbar.

Background Image Click the Browse button  to navigate to an image file (in JPG format) to use as the

background. The background is the area that appears behind the slides, sidebar, and toolbar.

4 Click OK.

The theme preview on the right side of the Theme Editor dialog box is updated to reflect your choices.

5 Click OK.
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Delete a theme

You can delete a custom theme at any time, however, the default themes included with Presenter, such as Sage and

Sapphire, cannot be removed.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.

3 From the Theme Name pop-up menu, select the theme you want to remove.

4 Click Delete.

5 A confirmation dialog box appears. Click Yes.

6 Click OK.

Show and hide theme panes

Panes appear in the sidebar of a theme. The default location of the sidebar is on the right side, but the location can

be changed. You can select which panes appear in the theme and which are hidden. For example, you might want to

include the Outline and Search panes, but hide the Thumbnail and Notes panes.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.

3 In the General Options area on the left, select the panes that should appear and deselect the panes you want to hide.

The theme preview on the right side updates to reflect your choices.

4 Click OK.

Set a default theme pane

Panes are part of a theme and appear in the sidebar. If you have more than one pane in a theme, the panes are layered

on top of one another with a tab at the top containing the name of the pane. You can select the pane that appears in

front of the others. If you are displaying all of the panes, select from Outline, Thumbnail, Notes, and Search.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.

3 From the Panes pop-up menu, select the pane that should appear by default when the presentation appears.

The theme preview on the right side is updated to reflect your choices.

4 Click OK.

Choose a location for the sidebar

The sidebar in a theme contains presenter information, panes such as Outline and Search, and presentation timing

information. You can position the sidebar on the right (default) or left side of the theme.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.
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3 From the Location of Layout pop-up menu, select Left or Right.

The theme preview on the right side is updated to reflect your choices.

4 Click OK.

Set presenter options for a theme

You can select exactly which presenter options appear in a theme. For example, you might want the presenter name

and photo to appear, but not a biography (bio) or contact information.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

The Theme Editor dialog box appears.

3 In the Presenter Options area, select the options to include in your theme:

Presenter Photo Select to include a presenter photo in the published presentation.

Presenter Name Select to include the presenter's name in the published presentation.

Presenter Logo Select to include a logo in the published presentation.

Presenter Bio Select to include a link to a presenter biography.

Presenter Contact Information Select to include a link to presenter contact information such as a phone number or

e-mail address.

Presenter Title Select to include the presenter’s title, such as Director of Human Resources.

The theme preview on the right side is updated to reflect your choices.

4 Click OK.

Use PowerPoint templates with Presenter
In Presenter presentations, the slide background is determined by settings in PowerPoint. You can customize the

background of the slides in a presentation by using PowerPoint design templates. When you apply a design template,

all slides in the presentation are assigned the design template background.

For example, you might create a presentation in PowerPoint using the design template named Technology, add the

theme named Arctic in the Presenter Theme Editor, publish the presentation to Connect Enterprise Server, and view

the presentation. You notice that the theme clashes with the slide background of the Technology design template.

Follow the procedure below that corresponds to the version of PowerPoint installed on your computer. (To check

which version of PowerPoint you have, open PowerPoint, click the Help menu, and select About Microsoft Power-

Point.)

See also

“Create and edit themes” on page 55

“Preview a presentation” on page 10

Use PowerPoint 2000 templates as slide backgrounds

1 In PowerPoint, open a presentation (PPT file).

2 From the Format menu, select Apply Design Template.
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Note: If the Apply Design Template dialog box does not open to the Presentation Designs location on your computer,

browse to the location at Program Files\Microsoft Office\ Templates\Presentation Designs.

3 Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.

4 To test the design template background with the presentation theme, publish your presentation locally and view

the results. (In PowerPoint, select Adobe Presenter menu > Publish. Select My Computer and click Publish.)

Use PowerPoint 2003 templates as slide backgrounds

1 In PowerPoint, open a presentation (PPT file).

2 From the Format menu, select Slide Design.

3 Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.

4 To test the design template background with the presentation theme, publish your presentation locally and view

the results. (In PowerPoint, select Adobe Presenter menu > Publish. Select My Computer and click Publish.)

Use PowerPoint XP templates as slide backgrounds

1 In PowerPoint, open a presentation (PPT file).

2 From the Format menu, select Slide Design.

3 Select an appropriate template that matches the theme you have chosen for your presentation and click Apply.

4 To test the design template background with the presentation theme, publish your presentation locally and view

the results. (In PowerPoint, select Adobe Presenter menu > Publish. Select My Computer and click Publish.)

Add a logo
Note: If you added a video file, such as a “talking head” video file of a person speaking, that video is displayed in the logo

area. If you add a logo file, the video file takes precedence and the logo will not be displayed.

You can add a custom logo to display in the Presenter viewer. This is a way to customize your presentations so that

they look like other multimedia and publications your organization produces.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Click the Presenter tab and do one of the following:

• Add a new presenter by clicking Add.

• Select an existing presenter and click Edit.

4 Next to the Logo text box, click Browse.

5 Navigate to the location of the logo file you want to use (JPG or PNG format).

Note: A logo size of 148 x 52 (pixels) is recommended so that the logo appears properly in the theme and the Presenter

viewer.

6 Select the file and click Open.

The name of the file is displayed in the Logo text box and a preview of the logo appears on the right side.

7 Click OK.

8 To preview the custom logo, publish your presentation locally and view the results. (In PowerPoint, select Adobe

Presenter menu > Publish. Select My Computer and click Publish.)
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Include slide notes in presentations
You can include extra notes about a slide in your final presentation. Users view the notes by clicking on the Notes

pane in the viewer sidebar. Slide notes are a good location for extra information about a slide such as numerical

details, supporting materials, or footnote text. You can also use slide notes to communicate with users who do not

have audio capabilities or are hearing impaired. You create slide notes in PowerPoint.

Note: The notes appear in the Presenter viewer as unformatted text. Any formatting applied to notes in the PowerPoint

note pane is ignored.

1 In PowerPoint, open a presentation (PPT file).

2 Navigate to a slide for which you want to add a note.

3 Ensure that you are in Normal or Notes Page view.

4 Type note text directly into the notes area under the slide. (If you are in Normal view, but cannot see the notes

area, it might be collapsed. Click the separator bar until the pointer changes to allow you to drag the separator bar.

Drag up to display the notes area.)

To view the notes area, move the mouse pointer over the separator bar until an equal sign with two arrows appears, then drag up.

5 You can preview the notes by publishing your presentation locally, viewing the results, and clicking on the Slide

Notes pane in the sidebar. (To publish locally, in PowerPoint, select Adobe Presenter menu > Publish. Select My

Computer and click Publish.)

This example shows PowerPoint slide notes in the Notes pane of the sidebar.

Change presentation settings
You can change settings, such as the title and summary, and some presentation behavior, such as pausing and

looping, using the presentation settings dialog box.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Click the Settings tab.

Title Type in a name for the presentation.The title appears in the Presenter viewer.

Summary Type in a summary for the presentation. A summary is usually a short description of the presentation

contents. This optional presentation summary is a useful organizational tool for authors. The summary appears only

in the settings; it does not appear in the published presentation and is not visible to users.
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Note: The presentation summary does appear in Connect Enterprise Server after a presentation is published to the

server. Summaries can be edited through Connect Enterprise Manager. Presentation authors can search summaries and

see the summary when viewing content information.

Auto play presentation on start Select to have the presentation automatically begin playing when it is opened. (If

this option is not selected, a presenter or users must click the Play button in the toolbar to start the presentation.)

Include slide numbers in outline Select to include the slide number within the Outline pane when the presentation

is displayed.

Pause after each animation If your presentation contains PowerPoint animations, select this option to pause the

presentation automatically after the animations play. This is useful if you want to clearly define where the animation

ends and the presentation begins again. (After clicking through each animation, you will need to click the Play button

on the playbar to start the presentation again.)

Loop presentation Select to have the presentation loop and replay continuously when opened.

Time to wait for slides without audio Select an amount of time (in seconds) for slides without audio to appear. (By

default, slides with audio play for the length of the associated audio file.)

4 Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published

presentation.

Automatically play a presentation
You can set an option so that a presentation automatically plays when it’s opened, or you can require that a presenter

or user click the Play button in the toolbar to start the presentation.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Click the Settings tab.

4 Select Auto Play Presentation on Start. (By default, this option is selected.)

If this option is not selected, a presenter or users must click the Play button  in the toolbar to start the presen-

tation.

5 Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published

presentation.

Loop a presentation
You can set your presentation to play once and then stop (the default setting), or to loop and replay continuously.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Click the Settings tab.

4 Select Loop Presentation.

5 Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published

presentation.
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Change slide display timing
You can change the display time for slides without audio. (By default, slides with audio play for the length of the

associated audio file.) This is useful for controlling the overall speed at which presentations without audio play.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Presentation Settings.

3 Click the Settings tab.

4 In the Time to Wait for Slides Without Audio text box, enter a new number (in seconds) or use the up and down

arrows to set a new number.

5 Click OK to close the Presentation Settings dialog box. Your changes will be incorporated into the published

presentation.

Set a presentation to open in full-screen mode
You can choose to have your presentation open normally or in full-screen mode. Normally, the presentation appears

with the toolbar and the sidebar. As an alternative, you can have the presentation open in full-screen mode with only

a small, modified toolbar appearing in the bottom right corner.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Theme Editor.

3 The Theme Editor dialog box appears.

4 From the Default Mode on Startup pop-up menu, select Default or Fullscreen.

5 Click OK.

Publishing and viewing in Connect Enterprise Server

About Adobe Connect Enterprise Server 6
For others to view your presentation, you must publish the presentation to Connect Enterprise Server. Users can see

your presentation in the viewer within Connect Enterprise, as part of a course or curriculum in Connect Training,

or with a URL provided by the Content library. The Presenter viewer delivers rich-media content in a powerful,

interactive format.

Connect Enterprise is a web communication system that lets you quickly and easily view presentations, attend

meetings, and receive training over the Internet using the familiar PowerPoint application, web browsers, and Flash

Player.

Note: Users do not need to have PowerPoint installed in order to view a presentation created with Presenter. Only the

person creating presentations needs to have PowerPoint installed.

Connect Enterprise includes a set of components that provides an integrated solution. Connect Enterprise can be

deployed with some or all of these components:

Adobe Acrobat Connect Professional lets you view and participate in a meeting over the Internet in real time.

Connect Training lets you participate in online training systems including integrated surveys, tracking, analysis, and

course management.
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Connect Events provides tools to manage the full cycle of an event, from registration and qualification of users to

post-event follow-up.

Access your Connect Enterprise Server account
You can access your Connect Enterprise Server account quickly and easily from Presenter.

❖ From the Adobe Presenter menu, select Manage Account.

Your default web browser opens and the Connect Enterprise Server login page appears.

Note: You can change which Connect Enterprise server appears when Manage Account is selected by clicking Adobe

Presenter menu > Preferences, and in the Connect Enterprise Server tab, selecting a different server in the publishing list,

and clicking Close.

Manage the Connect Enterprise Server publishing list
Presenter provides you with an easy way to maintain a list of Connect Enterprise servers that you publish to regularly.

You can add one or several Connect Enterprise servers to the publishing list. After a server has been added to the

list, it’s easy and quick to publish to that server.

Add a Connect Enterprise server to the publishing list

Before you can publish to a Connect Enterprise server, you need to add information, such as a name and URL

address, to the publishing list. You can add as many Connect Enterprise servers to the list as necessary.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Click the Servers tab.

4 Click the Add button.

5 In the Name text box, enter a unique name for the server. (This is only used locally to help you distinguish between

multiple servers easily.)

6 In the URL text box, enter the exact URL address of the server.

Note:The URL you enter here is the same URL you use to log in to Connect Enterprise Manager. If you do not know this

URL, consult your Connect Enterprise administrator.

7 Click OK.

The server now appears in the publishing list and you can select it in the Publish dialog box.

Note: The server that is highlighted in the publishing list is the one that will be used when you publish to Connect Enter-

prise Server.

8 Click Close.

Edit a Connect Enterprise server in the publishing list

After you have added a Connect Enterprise server to the publishing list, you can edit the server name or URL at any time.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Click the Servers tab.

4 Select a server in the list and click Edit.
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5 Make any necessary changes to the server name or URL.

6 Click OK.

7 Click Close.

Remove a Connect Enterprise server from the publishing list

You can remove a Connect Enterprise server from the publishing list.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Preferences.

3 Click the Connect Enterprise Server tab.

4 Select a server from the list and click Delete.

5 Click OK.

6 Click Close.

Publish to a Connect Enterprise server
After creating and previewing your presentation, you can publish the presentation directly to a Connect Enterprise

server in your publishing list. You can fully integrate Presenter presentations with Connect Enterprise so that, for

example, presentations containing quizzes can have quiz results automatically sent to and managed by a Connect

Enterprise server.

Note: To publish to a Connect Enterprise server, you must be connected to the Internet and have a Connect Enterprise

account.

When you publish to Connect Enterprise, the presentation is published to the Content library. The presentation can

be taken from the Content library, and pulled into Acrobat Connect Professional or Connect Training.

Note: A Presenter presentation must be 100 MB or smaller in size to publish to a Connect Enterprise server. (You can

create a Presenter presentation that is greater than 100 MB in size, but it cannot be published to a Connect Enterprise

server.)

To publish to a Connect Enterprise server, you follow this general workflow: Select a Connect Enterprise server, log

in to Connect Enterprise, select a location for your presentation, enter information about the presentation, and

finally set permissions specifying who can view it.

Select a Connect Enterprise server

The first step in publishing a presentation to a Connect Enterprise server is to select the server from the publishing

list to which you want to publish.

1 In PowerPoint, open a presentation (PPT file).

2 From the Adobe Presenter menu, select Publish.

3 On the left side of the Publish dialog box, select Adobe Connect.

4 Check that the Name and URL information is correct. If the information is not correct or if you need to publish

to a different server, click Server Settings.

5 (Optional) Check the Presentation Information area on the right side. If you want to edit any of the options, such

as Presenter Name or Loop Presentation, click Settings.
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6 (Optional) If you want to publish the presentation source files (PPT and PPC) along with the SWF file, select

Upload Source Files to the Server. This option is useful if multiple authors are working on a presentation or if you

think the presentation will need to be updated later and you want to keep all of the files stored in one location.

7 (Optional) You can change the theme by clicking on the Theme pop-up menu and selecting a different theme.

(The preview is updated to reflect your choices.)

8 Click Publish.

The presentation is created and the Connect Enterprise Login screen appears.

The next section describes how to log in to your Connect Enterprise account.

Log in to Connect Enterprise

The next step in publishing a presentation is to log in to your Connect Enterprise account. You must have an account

and the correct security permissions before publishing a presentation. (To obtain permission to create and update

presentations, contact your Connect Enterprise administrator.)

1 On the Connect Enterprise Login screen, enter your login name (usually your account e-mail address).

2 Enter your password.

3 Click Login.

The next section explains how to select a location in which to save a presentation.

Select a location for the presentation

The third step in publishing a presentation is to select a location in your Connect Enterprise account in which to

store the presentation. After you log in to Connect Enterprise, your personal user folder in the Content library

appears. Select a location in your Connect Enterprise Account library for the presentation.

Note:The Content library displays only your presentations. Other Connect Enterprise content, including SWF files, FLA

files, and JPG files, are not displayed when you view the Content library.

Note: If you have already published the presentation to the server, you are prompted to save over the previous version or

to save the presentation to a new location.

1 In the Adobe Connect Publish screen, navigate to a folder within your Connect Enterprise Account library in

which to store the presentation.

• To open a folder and display its contents, click the name of a folder. The folders and files within that folder are

displayed. The navigation path for links near the top of the browser window is updated to indicate the directory

path to the selected folder.

• To publish changes to a presentation already located in the folder, click Update Existing Presentation. The new

version of the presentation overwrites the existing presentation.

• To create a new folder, navigate to the location where you want to add a new folder, click the New Folder button,

enter a name for the new folder, and click Save.

Note: You can create folders only if you have manage permissions for the parent folder.

• To move up to the parent folder (the folder one level above the current folder), click the Up One Level button in

the navigation bar above the content list.

2 Click Publish to This Folder.

The next section explains how to enter descriptive information for the presentation.
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Enter presentation information

The fourth step in publishing a presentation is to provide identification information about the presentation. You

must specify a title for the presentation. You also have the option of adding a custom URL to view the presentation

and a brief description.

1 In the Content Information dialog box, enter a unique name for the presentation in the Title text box.

2 (Optional) In the Custom URL text box, you can create your own URL to view the presentation. This option is

useful if you want to create a URL to view the presentation that can be remembered easily. If you leave this text box

blank, Connect Enterprise automatically creates a generic, but unique, URL for the presentation.

3 (Optional) In the Summary text box, type in a short description of the presentation. (Maximum length of the

summary is 750 characters.)

4 Click Next.

The final step in the publishing process is to set permissions for who can view the presentation.

Set permissions

The final step in the publishing process is to set permissions for the presentation. This establishes who is able to view

the presentation. You have several options available.

1 On the Set Permissions screen, select a permission setting.

• The default permission setting is Same as Parent Folder. If you select this option, the presentation automatically

inherits the same permission profile as the parent folder in which it’s published. For example, if the parent folder

has permission for public viewing, the presentation will also have permission for public viewing.

• To change the permission setting, click Customize. To create a public presentation, select Yes next to the Allow

Public Viewing option. To create a private presentation with a custom permission profile that is different from that

of its parent folder, make sure the Allow Public Viewing option is not selected. Then, create a list of users and

groups with specific permission types. In the Available Users and Groups list on the left, select a group or

individual and click Add. The new user or group now appears in the Current Permissions list on the right.

Continue adding or removing users or groups as necessary.

2 Click Finish.

3 A dialog box appears and confirms that the project was successfully published to the specified Connect Enterprise

server. Click OK.

The Content Information dialog box appears. This screen lists important information about the presentation,

including the URL for viewing. If you click the URL, the presentation is displayed and begins to play. To share the

presentation with others, you can send them the URL by clicking E-mail Link, or by cutting and pasting the URL

into an e-mail. (For users to view the presentation, the published presentation or the folder containing the presen-

tation must have the correct permissions set.)

4 Click OK to complete the publishing process.

Add a Presenter presentation to an Acrobat Connect Professional meeting
Adobe Presenter lets you create e-learning content and high-quality multimedia presentations containing slides,

streaming audio, synchronized animation, and navigation controls rapidly using Microsoft PowerPoint as a base.

After you have published a Presenter presentation to Connect Enterprise, you can add the presentation to an Acrobat

Connect Professional meeting by bringing the presentation file into the meeting from the Content library or directly

from your computer. When viewing the presentation in Acrobat Connect Professional, you have complete control

over the screen side, slide navigation, and audio.
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Note: Adobe recommends adding presentations to an Acrobat Connect Professional meeting from the Content library.

Presentations uploaded directly from your computer and into an Acrobat Connect Professional meeting do not support

some Presenter features. For example, if you share the presentation PowerPoint (PPT) file, presenter photos, presenter

logos, and the Thumbnail pane are not displayed.

Add a presentation from the Content library to an Acrobat Connect Professional meeting

Adding a presentation to an Acrobat Connect Professional meeting from the Content library is a good method to

use if you publish all of your presentations to the library and manage them from that location. (You also have the

option to add a presentation to an Acrobat Connect Professional meeting directly from your computer.)

1 Open your web browser and navigate to your Connect Enterprise server.

2 Log in using your login name and password.

3 Click the Meetings tab.

4 Select a meeting from the list.

5 Click Enter Meeting Room.

The Acrobat Connect Professional Meeting appears.

6 Select Pods menu > Share > Select from Content library.

7 Select the presentation and click Open.

8 The Presenter presentation appears in the Acrobat Connect Professional meeting.

Add a zipped presentation from your computer to an Acrobat Connect Professional meeting

If you have a Presenter presentation stored on your computer, you can add the presentation directly from that

location into an Acrobat Connect Professional meeting. This is a good method to use if you need to place a presen-

tation into an Acrobat Connect Professional meeting, but the presentation has not been published to the Content

library. For example, you might have a presentation that you have not published because it is incomplete, but you

want to show a preliminary version in an Acrobat Connect Professional meeting.

Note: Adobe recommends adding presentations to Acrobat Connect Professional Meeting from the Content library.

Presentations uploaded directly from your computer and into an Acrobat Connect Professional meeting do not support

some Presenter features. For example, if you share the presentation PowerPoint (PPT) file, presenter photos, presenter

logos, and the Thumbnail pane are not displayed.

1 In Presenter, publish your presentation locally and select the Zip files Output Option. (To do this, click the Adobe

Presenter menu, select Publish, click My Computer, select the Zip file option, and click Publish.)

2 Open your web browser and navigate to your Connect Enterprise server.

3 Log in using your login name and password.

4 Click the Meetings tab.

5 Select a meeting.

6 Click Enter Meeting Room.

The Acrobat Connect Professional meeting appears.

7 From the Share pod, select Documents > Select from My Computer. (If a Share pod is not open, click the Pods

menu and select Share > Share.)

8 Navigate to the presentation folder on your computer.

9 Select the presentation zip file and click Open.
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10 The Presenter presentation appears in the Acrobat Connect Professional meeting.

Add a presentation PowerPoint (PPT) file from your computer to an Acrobat Connect Professional meeting

1 Open your web browser and navigate to your Connect Enterprise server.

2 Log in using your login name and password.

3 Click the Meetings tab.

4 Select a meeting.

5 Click Enter Meeting Room.

The Acrobat Connect Professional meeting appears.

6 From Share pod, select Documents > Select from My Computer. (If a Share pod is not open, click the Pods menu

and select Share > Share.)

7 Navigate to the presentation PowerPoint (PPT) file.

8 Select the PPT file and click Open.

9 The Presenter presentation appears in the Acrobat Connect Professional meeting.

View a presentation in an Acrobat Connect Professional meeting
After you publish a presentation to a Connect Enterprise server and then add the presentation to an Acrobat Connect

Professional meeting, the presentation is ready to view. All of the features in the presentation, such as audio, synchro-

nized animation, quizzes, and presenter information, appear.

Note: If you upload your presentations directly from your computer and into an Acrobat Connect Professional meeting,

some Presenter presentation features, such as presenter photos and presenter logos, are not supported. Adobe recom-

mends adding presentations to Acrobat Connect Professional meetings from the Content library.

If the presentation contains quiz or survey questions, user interactions with the questions are fully tracked by the

Connect Enterprise server as part of the meeting’s reports.

The layout of a Presentation consists of the following parts:

Presentation The main part of the window, which displays the presentation slides.

Presentation sidebar An area on the right side (default location) of the browser window that shows the name of the

presentation, the presenter information, and the Outline, Thumb, Notes, and Search panes (if you have added the

panes to your theme) The Presentation sidebar is shown in Normal view; it is hidden in Full Screen view.

Presentation toolbar A control bar at the bottom of the presentation, which gives you control over the presentation

playback, audio, attachments, and screen size.

See also

“Preview a presentation” on page 10

Viewing the Outline pane

Most presentations have an Outline pane on the sidebar. The Outline pane lists the title and duration of each slide.

Use the Outline pane to display information and to enable users to move to individual slides in the presentation. You

can omit the Outline pane from the sidebar. At this time, it is not possible to show the slide outline in a read-only

format; if the outline is showing, users will be able to click the slides listed.
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Note: Quiz slides are not, by default, listed in the Outline pane. If you want quiz slides to appear in the Outline, open

the Quiz Manager, click Edit Quiz Settings, and select the Show questions in outline option.

Note: If you have a Windows XP English PC and need to view double-byte unicode characters (for example, Japanese

characters) in the outline pane, you should have the Arial Unicode MS font installed on your computer.

❖ Click the Outline pane in the sidebar on the right side.

The Outline pane contains the following features:

• The current slide is highlighted with a glow color. (This color can be changed in the theme.)

• The entire slide title appears when the pointer is held over the title.

• The duration of the slide is shown next to each slide.

• You can move to any slide in the presentation by clicking the slide title in the Outline pane.

The Outline pane
A. Selected slide currently previews B. Hover cursor over title to see the entire title

View the Thumb pane

Presentations can have a Thumb pane on the sidebar. The Thumb pane shows a small picture of each slide, the slide

title, and the slide duration. You can use the Thumb pane to see the contents each slide quickly and to move to a

specific slide in the presentation.

Note: If you upload your presentations directly from your computer and into an Acrobat Connect Professional meeting,

the Thumb pane is not displayed. Adobe recommends adding presentations to Acrobat Connect Professional meetings

from the Content library.

❖ Click the Thumb pane in the sidebar on the right side.

The Thumb pane contains the following features:

• The current slide is highlighted with a glow color. (This color can be changed in the theme.)

• The entire slide title appears when the pointer is held over the title.

• You can move to any slide in the presentation by clicking the slide title in the Thumb pane.

View slide notes

When creating a presentation in PowerPoint, you can enter notes for individual slides. If any slide notes exist, they

can be displayed in the Presentation.

Note: Using slide notes is optional.

When slide notes appear, they are located on the right side of the presentation window. You cannot change the size

of the slide Notes pane.

❖ Click the Notes pane in the sidebar on the right side.

A

B
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The Notes pane contains the following features:

• The complete notes text is displayed. (The text is unformatted and cannot be edited directly on the pane.)

Search for text in a presentation

Users can use the Search pane (if you have included it in your theme) to find specific text in a presentation. For

example, in a presentation that serves as a company human resources handbook, a user might search for the word

vacation to find text about vacation leave policies.

1 Click the Search pane in the sidebar on the right side.

2 Type the text to search for directly into the text box. (Search is not case-sensitive.)

3 Click the Search button.

Search results are displayed below the text box. Click any slide title in the results list to display that slide.

Using the Search pane
A. Text box B. Search button C. Results

Use the presentation toolbar

You can control the presentation appearance and playback by using the toolbar located at the bottom of the presen-

tation.

The toolbar that appears in the published presentation contains useful buttons, controls, and messages.
A. Play B. Back C. Forward D. Position marker in slide progress bar E. Current slide time F. Total slide time G. Audio volume
H. Attachments I. Show/Hide sidebar

❖ Click any of the following buttons and features on the toolbar.

Play/Pause button Pauses and then resumes play of the current slide.

Back button Moves to the previous slide in the presentation.

Forward button Moves to the next slide in the presentation.

Slide progress bar Shows and controls the playback location within the current slide. The position marker moves as

the slide plays. You can drag the marker arrow forward or back in the current slide to change your location within

the slide playback. You can also click a specific location on the progress bar to move the slide marker position and

slide playback to that position. (If you added a video file, such as a “talking head” video file of a person speaking, the

slide progress bar also controls the video.)

Current slide number Shows the number of the currently displayed slide and the total number of slides (for example,

Slide 2 out of 10).

Status Shows the status of the current slide, such as Playing, Stopped, No audio, or Presentation complete.

B

C

A
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Time Shows the current slide time and the total slide time as the slide plays (for example, 00.02/00.05).

Audio volume Shows the volume level that is set for the slide.

Attachments Displays a small window showing any attachments (for example, documents, spreadsheets, images,

URL addresses, and so on) that have been added.

Show/Hide sidebar and toolbar Shows or hides the sidebar and toolbar.

Note: The behavior of the Forward button, Back button, and slide outline can be affected by settings in the Quiz

Manager. For example, if a learner must pass a quiz before continuing, clicking the forward button or a slide in the

outline that is beyond the quiz slide will have no effect unless the learner has passed the quiz.

Switch between viewing modes

You can view Presentations in two modes:

Normal The default viewing mode. It includes the presentation toolbar at the bottom of the browser window and the

presentation sidebar.

Full-screen An optional viewing mode in which the presentation toolbar is removed and the size of the presentation

slides increases to fill your browser window.

1 Click the Full Screen button at the bottom (lower right) of the Presenter viewer.

If the presentation outline was originally visible, the Presentation switches to full-screen mode without a presen-

tation sidebar. If a presentation outline is not originally visible, the Presentation switches to full-screen mode with

no toolbar.

2 Click the Full Screen button again to change viewing modes.

If presentation controls are originally visible, the presentation switches to full-screen mode without a presentation

outline or presentation toolbar. If a presentation toolbar is not originally visible, the presentation switches to normal

viewing mode with or without a presentation outline.

Navigate between slides

You can navigate between slides during playback by using the search pane, the presentation toolbar, or the presen-

tation Outline or Thumb pane.

Note: The Outline pane and Thumb pane are optional. Set panes for presentations using the Theme Editor in Presenter.

❖ Do one or more of the following:

• Click the Previous slide button  in the presentation toolbar to move to the previous slide.

• Click the Next slide button  in the presentation toolbar to move to the next slide.

• Click the title of a slide in the presentation Outline or Thumb pane to move to any individual slide in the presen-

tation.

• Use the Search pane to find specific slides.

Navigate within the current slide

❖ Do one or more of the following:

• Click the Pause button  on the presentation toolbar to pause slide playback.

• Click the Play button  on the presentation toolbar to resume slide playback.

• Drag the position marker arrow on the slide progress bar forward or backward to change your location within the

slide’s playback.
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Adjust the presentation audio

You can turn the presentation audio on and off or control the volume by using the audio button on the presentation

toolbar. Examples of presentation audio that the audio button can control include audio imported into a slide and

audio in an embedded SWF file (for example, a “talking head video”).

Note: Not all slides or presentations contain audio.

If a slide does not have any audio, the text No audio appears as the slide status on the slide progress bar. The slide still

has an audio length and appears for that period of time before the next slide appears. This time is set by the presen-

tation speaker.

❖ To change the audio level, click the Audio button in the presentation toolbar and move the volume bar up or

down. Moving the volume bar all the way to the bottom mutes the audio completely.

Viewing a presentation in Connect Training
You can use Presenter presentations within Connect Training courses. This enables you to quickly create e-Learning

courses for formal assessments, compliance training, or information sharing. The new curriculum feature allows you

to make your presentations part of a learning path. Quiz and survey results are tracked on a user-by-user and

question-by-question basis. The results data can be viewed in Connect Training reports.

Using presentations with Connect Events
Connect Events is a new application that provides tools to manage the full cycle of an event, from registration and

qualification of users to post event follow-up. The Connect Event dashboard and reports include user demographic

information, registration, and tracking at the individual user level. Connect Enterprise generates exportable files in

CSV format for import into CRM and other systems.

Note: If you want to use an existing Presenter presentation as an event, it is important to rename the presentation and

republish the presentation to a different location and different folder in the Connect Enterprise Content library. This

ensures that reporting information for the event does not include reporting information from prior events.

Using presentations with third-party learning management systems
Presenter lets you use presentations with any SCORM or AICC compliant learning management system (LMS). Use

the Reporting tab in the Presenter Quiz Manager to choose the correct reporting settings for the LMS and to create

a content package that can be uploaded to the LMS.

Troubleshooting presentations

Optimizing Flash (SWF) files
Each slide in a presentation is loaded as an individual external Flash asset and can be augmented with any SWF file.

When working with embedded SWF files, follow these guidelines:

• Author the Flash SWF file at 30 frames per second. Presenter presentations are created at 30 frames per second,

so Flash files with the same setting can be integrated into the presentation smoothly.

• In Flash, set the maximum canvas size to 720 x 540 pixels.

• Don’t use _root or absolute movie clip references. Use relative paths in the MovieClip object references, not _root.
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• The SWF file you want to embed must not attempt to make any changes outside its own file. Therefore, the code

cannot refer to the following variables: _level#, _global, or stage.

Control inserted SWF files
If you added a SWF file to a presentation, but are having trouble using the Presenter playbar (Stop, Pause, Play, or

other buttons) to control the SWF file in the viewer, you may need to change a setting.

Note: SWF files authored at 30fps work best in presentations.

Specify how an inserted SWF file is controlled

1 In PowerPoint, open a presentation (PPT file) that contains an added SWF file.

2 From the Adobe Presenter menu, select Presentation Settings.

3 Click the Flash Files tab.

4 Select one of the Flash files in the list.

5 Select the Controlled by Presentation Playbar option.

You will now be able to control the selected Flash file by using the Presenter playbar in the published presentation.

6 Click OK.
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